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This manual introduces you to the Mesquite system for analysis in evolutionary biology. It
explains the basic operation of the system (the links above) and some standard analyses (the
links at left).

New features and bug fixes since version 1.0 are described on the page on new features and
history of changes. Version 2 is incompatible with modules from version 1, and thus you will
need to find new versions of any third-party modules you have from version 1.

Mesquite's analyses currently include phylogenetic analyses (parsimony, likelihood,
comparative method, simulations and randomizations of characters and trees) and
population genetics analyses (coalescence). You can also use Mesquite as an editor for
phylogenetic data files. Mesquite is not primarily designed to infer phylogenetic trees, but
rather for diverse analyses using already inferred trees. Mesquite's web site contains an
outline of Mesquite’s features.

Because many analyses are possible and those available depend on what modules are
installed and loaded, a comprehensive manual cannot easily be written. For this reason,
many analyses available in Mesquite are not included in this manual. You are encouraged to
explore, and invent new analyses. We have a special page on how to learn about Mesquite's
features.

Mesquite’'s web site is here; check it for updates. We recommend you sign up to the
Mesquite discussion e-mail list to learn about updates and to discuss features.

Getting started
To begin using Mesquite on the Mac OS, Unix/Linux or Windows, see the installation

instructions. We encourage you to explore the example files in the "examples” directory of
the Mesquite_Folder.
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See the Help page to learn how best to learn Mesquite.

The website has a list of some third-party modules you can install. See the page on modules
for instructions on where they can be installed.

Reporting Bugs

We encourage you to report bugs or misbehaviour of Mesquite. You may find a problem that
seems so obvious to you that you expect we must have seen it. Please report it anyway,
because perhaps it occurs only in particular circumstances that we didn't test, or it occurs
with a combination of options that we haven't tested recently. The Support page has more
details on reporting bugs.

Conventions of this manual

For compactness, we will use a special convention to refer to menu items. For example,
File>Save File refers to the Save File menu item of the File menu. (Tree Window)Drawing>Tree
Form>Diagonal Tree refers to the Diagonal Tree menu item of the Tree Form submenu of the
Drawing menu that is associated with the Tree Window. By referring to a menu as
"associated with" a window, we mean that that menu is present in the menu bar at the top
of the screen when the window is frontmost (on the MacOS), or that the menu is embedded
within the window (on the Windows OS and most other operating systems).

Information for Developers

Mesquite is modular, and can be extended by adding modules into the folder "mesquite” in
the folder "Mesquite_Folder". Developers interested in writing modules should contact us at

develop@mesquiteproject.org  |nformation on development for Mesquite is also available
here, although it is out of date.
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1 ™
Search Online Manual

Mesquite Help: Learning how to use Mesquite
Table of contents
e Documentation and help facilities

e How to remember what you've done
e Why is Mesquite complex? (Understanding this may help you know what to do...)

Mesquite's documentation and other learning aids

Because of Mesquite's complexity we have provided various aids to help you discover and
learn features:

Manual: This manual provides an introduction to Mesquite, including instructions for
accomplishing some analyses. It resides in the docs subdirectory of the Mesquite_Folder
directory, and is also available from the Help menu while Mesquite is running.

Search Features: Most windows have a small text box (usually near the top of the window)
beside the words "Search Features” or "Search Data". When set to Search Features mode
(which you can request by clicking on the little symbol until it shows "&" or "/"), you can use
this to find features and how to use them. Enter text there and hit Return, and the text will
be sought. There are several modes, marked by different symbols:

o Search Features — Search Features, AND: searches through information
about Mesquite's features and returns a description of those features matching ALL of
the search terms

o search Features — Search Features, OR: searches through information
about Mesquite’'s features and returns a description of those features matching ANY of
the search terms

(The Search Data feature [“! searches the current data file or project and returns objects
(e.g. taxa, characters, sequences) that match the search string.)

The results of the search are shown in the main Mesquite window (shared by the Log
window). The results may list modules, tools or manual pages that match the search terms.
If you touch on the name of a manual, you may get a list of the contexts in which this
module can be used. (Please: we realize that the search results can sometimes be long and
difficult to follow. Please give us your feedback as to what you would most want to know in
response to a search, so that we can improve this feature.)

Example files: One of the best ways to learn about analyses is via the example files, which
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are distributed with the main Mesquite package and with various of the add-on packages.
The example files are present in the "examples” folder of Mesquite_Folder. Some additional
examples are outlined on the Studies page.

Explanation areas: Explanation areas at the bottom of each window may describe the
window, its contents, or the function of a selected button or other object. If you hold down
the Shift key as you select a menu item, an explanation for it will (usually) appear in the
explanation area of the frontmost window. Explanations areas are also present in some
dialog boxes.

Web Search: This menu item uses a web browser and the Google Search engine to search
for terms entered by the user. Users may restrict their search to the Mesquite Manual if
desired.

Mesquite FAQ: There is a preliminary Frequently Asked Questions page.

Window information bar: The small tabs near the top of each window allow you to select a
view: Graphics, Text, Parameters, Modules and Citations. The Modules view in particular can
help you learn about Mesquite calculations. It shows the set of modules currently active in
the analysis and or graphics shown in the window. This is shown as a tree of modules
employing other modules (a bureaucratic hierarchy!). If you pass the cursor over a module
name, an explanation for it appears in the explanation area at the bottom of the window. If
you touch on the name of a module, a menu will appear with choices to show more
information (if available). If there is a special manual for the module, an extra label will
appear that will link you to the manual.

Additional web pages: Mesquite surveys modules for information and composes a set of web
pages. These web pages list all the modules loaded, brief explanations as to what these
modules do, and the scripting commands these modules respond to. These Mesquite-
composed HTML pages are in a directory called "Mesquite_Prefs" within a directory
Mesquite_Support_Files, which may reside in different places depending on your operating
system. If you can find these pages, you might want to store a bookmark, or alias, or
shortcut to one of them so that you can find them again without going through Mesquite.

Menu & Control Explanations: The menu item Window>Menu & Control Explanations causes
Mesquite to compose a HTML page summarizing the menu items or buttons for the current
window, and to show it to you.

Keyword Search: This menu item in the Help menu of Mesquite provides a currently-
primitive facility to search among the names and explanations of all of the installed and
loaded modules to find a keyword. You could, for instance, search for "simulat” to find all of
the modules that might have to do with simulations.

Thus, if you want to learn about:

e Modules:
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o Use the menu items in the Help menu to go to the appropriate HTML pages for
modules or packages. You can also get to the HTML pages of packages by
touching the banners in the Mesquite startup window (the window named "About
Mesquite”).

o Use the Search Features facility in each window

o Open the Modules view of the window of concern (using the tab in the
information toolbar) and move the cursor over the names of the modules to see
explanations in the explanation area, or touch on their names to go to their
information pages composed by Mesquite.

¢ Menu items

o Hold down Shift as you select a menu item to make an explanation for it appear
in the explanation area of the frontmost window.

o Use the Menu & Control Explanations menu item of the Window menu to make a
web page summaring the functioning of the menus and buttons for the foremost
window.

e Buttons and tools:

o Touch on a tool in the tool palette to make an explanation for it appear in the
explanation area of the frontmost window.

o Use the Menu & Control Explanations menu item of the Window menu to make a
web page summaring the functioning of the menus and buttons for the foremost
window

How to remember or document what you have already done?

With an interactive program having as many options as Mesquite, it can be difficult to
remember what options are currently in effect. Three facilities help you keep track of what
you've done.

¢ [nformation bar of windows. The information bar has various tabs that control
alternative views of a window's contents. Some of these give information about the
current calculations, the parameters in use, and details about the modules in use by
the window.

e The Log Window, available by selecting Mesquite Log in the Window menu, records
commands given and messages relayed to the user. This text is also saved
automatically to a file called "Mesquite Log" within the directory
Mesquite_Support_Files.

e Auto-scripting for file saving. When Mesquite saves NEXUS files, it automatically
constructs a script that attempts to return an analysis to its current state. This not
only allows a user to save a snapshot of an analysis, but the script itself can also be
inspected to determine current parameters (in case that's not evident otherwise).
Snapshot scripts can also be seen for individual windows, by selecting the appropriate
item in the Scripting submenu of the Window menu.

Why Mesquite is complex

file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/help.html Page 3 of 5


file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/windows.html#infoBar

Mesquite Help 23.10.2007 4:27 PM

Mesquite has many options depending on what modules are installed and loaded. Its
modularity and flexibility allow for many possible analyses, but also create challenges for
the user (and the manual writer). There are too many possible analyses for us to have yet
written instructions specifically for each. If the user wants to perform some particular
analysis, he or she may have to use his or her puzzle-solving ability to figure out how to
achieve the analysis by combining Mesquite's various functions.

Why are so many choices? Why do some analyses assault you with a guantlet of many
dialogs? These are consequences of Mesquite's flexibility. We have tried to protect you from
complexity as much as possible.

You may find a slightly different rhythm of thinking will be needed when confronting
Mesquite. For instance, suppose you wanted to see how much the likelihood for a character
varies if random noise is added to the branch lengths of the phylogeny. If you were lucky,
there would be a macro or some menu item that would build your desired analysis directly,
but for this question there isn't currently such a shortcut. What you'd like to see is a
frequency distribution of likelihoods calculated for the character over a series of trees, each
tree derived from some given tree by adding random noise to the branch lengths. This
sounds like a bar chart (histogram), but which bar chart? It seems to concern characters, so
perhaps it is a Characters bar chart? No, each sample point is a tree, and thus you should
ask for a Trees bar chart. When a dialog box asks you what value to calculate for the trees,
what do you say? The likelihood concerns a character, and thus you respond "Tree value
using character”. In the next dialog, you can choose character likelihood. You will also be
asked what source of trees. The trees are randomly modified by adding noise to the branch
lengths; therefore, choose "Randomly Modify Tree" and for the particular modification, "Add
noise to branch lengths”. Although this may seem complex, it does allow you to design the
analysis exactly as you wish. You may use the example files, instructions in this and other
manuals, and the Mesquite discussion list in order to learn how to do the analyses you need.

Features that help reduce Mesquite's complexity to the user are:

¢ Primary Choices: Submenus and dialogs boxes with lists of alternative choices may
have a small number of choices listed then an item "Other Choices..." (if a submenu) or
a check box "Show Secondary Choices” (if a dialog box). If these are selected, a larger
number of choices is offered, including the "secondary” choices. This division of choices
into the primary choices (the ones we expect will be most frequently selected) versus
the secondary choices helps keep the commonly seen array of choices small. (This
division can be turned off in the Defaults menu of the Project and Files window or the
Log window.)

e Macros: Mesquite can be instructed by a scripting language. Macros can therefore be
written or automatically generated to script complex calculations. Macros appear in
submenus in the appropriate menu.

e Configurations: Even if many packages of Mesquite modules are installed, you can ask
Mesquite to load only a subset of them. This allows Mesquite to startup more quickly
and to present a simpler interface (i.e., with fewer options). You can control
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configurations using the submenu File>Activate/Deactivate Packages>.
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Why Mesquite was made

We give two answers, the practical and the poetic, and a comment on the relationship
between MacClade and Mesquite.

The practical answer

Mesquite represents a new approach to computing for evolutionary biology. In recent years
there has been a proliferation of computer programs for phylogenetic analysis, each
designed for some particular analysis (e.g., see Felsenstein's compilation of programs). As
these often involve unique file formats and user interfaces, it is difficult for users to move
from one to another. Users tend to become constrained to a few familiar analyses, since any
given program can't do everything, and each program has costs in learning. As a programmer
one would like to respond by making a program that does everything, but there are now too
many analyses available or conceivable for a single programmer or programming team to
keep up. We have seen the impact of these constraints with MacClade: some users perform
particular analyses in MacClade not because they are the most appropriate analyses for their
questions, but simply because they are available in a familiar program. We would like to add
more flexibility to MacClade, but in a monolithic program this can be difficult to do, and
even if easy, there are more proposed methods than we could maintain in MacClade.

Hence, our goal was to design a general system for phylogenetic computing to which
different programmers could contribute modules. Bringing different analytical tools into a
common system increases possible analyses more than additively. In the end, the system has
grown beyond being strictly phylogenetic, including capabilities for calculations involving
characteristics of many organisms (e.g. population genetics and morphometrics) that need
not involve phylogeny.

A second goal of Mesquite is to provide a graphical user interface that will operate, more or
less without modification, under different operating systems (being written in Java).

Modularity and Flexibility

"Modularity” in computer progamming might follow different models. It could follow the "Mr.
Potato Head" model, in which there is a central program to which different peripheral
calculations can be attached in specific places. This allows useful, but limited, flexibility.
Or, modularity could follow the "Lego” model, in which building blocks are attached to other
building blocks, and so on indefinitely. This allows nearly unlimited flexibility. Mesquite’s
modularity is somewhat of a hybrid between these: there is a (small) central starting point
to which modules attach, but from there modules can be attached to modules attached to
modules, indefinitely, leading to considerable flexibility in the analyses that can be
constructed.
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To give an idea of the flexibility, consider the calculation of the parsimony score of a tree,
the treelength. A treelength calculating module takes as input information a tree, and
responds by returning its length. Such a module belongs to the general class of modules that
return a number when passed a tree. Other modules belonging to this class
("NumberForTree") could return the likelihood of the tree, or a measure of the asymmetry of
the tree's branching, or a measure of the tree's discordance with a containing species tree. A
Tree Legend module can be written (and has been) that displays the treelength in a legend
in the tree window, but the Legend module is designed so that the user can choose to
display any other number for the tree, such as its likelihood, asymmetry, or discordance. If a
programmer creates a new module to calculate a number for a tree such as the longest
branch-length path from root to tip, and a user installs the module, then the longest path
measurement would automatically become another option for the tree legend.

The Tree Legend is not the only place where analyses could use numbers for trees. A
charting module could display the numbers calculated for a whole series of trees, or a tree
search module could use the numbers to find a tree with minimum or maximum values for
the number. When such modules are made, they can automatically have access to whatever
NumberForTree modules are available. Thus, the chart could show treelength, or likelihood,
or asymmetry, or discordance, or longest path. Likewise, the tree search module could seek
to optimize any of those. If a programmer makes a new module to analyze numbers for
trees, then suddenly all existing NumberForTree modules have a new context in which they
can be analyzed. If a new NumberForTree module is made, it will appear as a new option
under each of the modules making use of NumberForTree. Hence the number of alternative
analyses rises as the product of numbers of modules of different interacting types.

Of course, the trees used had to come from somewhere. One module might supply the trees
stored in a file, another might simulate trees using a simple markovian model of speciation
and extinction, another might simulate trees as gene trees coalescing within a species tree.
Characters likewise might come from a stored matrix, or might be simulated by a stochastic
module of evolution, or might represent reshufflings of existing characters. This means that
any calculations using trees or characters can either do their calculations on observed data
and reconstructed trees, or can derive null distributions under stochastic models. The
calculations don't have to do anything special to achieve this flexibility; they simply let the
user choose the sources of trees and characters.

(For more details about modularity, see How Mesquite works)

A community of programmers

Our hope is that building-block style of the Mesquite system will encourage programmers to
write modules for their own favorite analyses. Another attraction of the Mesquite system is
that many of the details of reading and writing of files, user interface and graphical display
are already taken care of, and the programmer might worry only about a single calculation.
The system is built in Java and is therefore platform independent. It is also possible for
programmers to link in code written in C, C++, or some other language.

file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/whyMesquite.html Page 2 of 4


file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/howMesquiteWorks.html

Why Mesquite? 23.10.2007 4:31 PM

We have attempted to design the system so that a programmer’s efforts can be recognized
as an independent, citable contribution. Modules or suites of modules can have their own
names, own manuals, be distributed and cited separately. They simply run within the
Mesquite system.

Mesquite source code is available for download. This allows other programmers to modify
existing source to create new modules.

The poetic answer

The goals of Mesquite are these:

To change the economics of imagination in evolutionary biology — There are three ways
we envision Mesquite stimulating imaginative ideas and their successful spread:

e Stimulating the creation of ideas: analyses. With multiple alternative modules available
for various parts of an analysis, and with modules specializing in questions from various
branches of evolutionary biology (e.g., phylogenetics, molecular evolution, population
genetics, geometric morphometrics) the diversity and scope of analyses that can be
constructed by combining different modules is great. Individual users can carry their
imaginations through to an analysis that no one has tried previously. Indeed, Mesquite,
by offering the alternatives to be combined, doesn't merely provide analytical tools for
questions that have existed: it suggests and provokes new questions.

e Stimulating the creation of ideas: biology. As does MacClade, Mesquite has an emphasis
on visualization and exploration. An idea — whether a particular hypothesis about the
evolutionary history of a group, or a stochastic model of a process — can be followed
through to its consequences, and visualized. A biologist can ask "What if this were the
phylogenetic tree?" and a character's evolution can be reconstructed or simulated on
this tree, and the results visualized. A biologist can ask "What if the population had
population sizes fluctuating in this way?", and coalescence can be simulated, and the
results visualized. In providing users with the tool to ask "What if?" questions, Mesquite
provides an extension of the imagination. Such tools are vital in a field whose ideas
have consequences that are difficult to predict or grasp without the aid of a computer.

e Enhancing the efficient distribution of ideas: programs. The imagination of
theoreticians and programmers has produced many valuable ideas for approaches and
methods, and many valuable programs to implement them. However, some of the
ideas haven't been translated to programs, and many of the programs haven't been as
much explored and used as would have been good. We don't know, as a field, how
many important ideas will lie unused for decades until they are rediscovered. By
allowing the programmer to focus on the precise idea proposed (Mesquite providing
much of the housekeeping code for the programmer), Mesquite may allow some ideas,
that might never have been implemented, to be realized as tools. By providing a fairly
user-friendly context in which modules can operate, Mesquite may encourage some
programs to be used more broadly and more easily than otherwise.
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To continue to promote a phylogenetic perspective in evolutionary biology — The last few
decades have seen the realization of the importance of viewing organismal diversity and
evolution in the light of phylogeny. This revolution is analogous to and as fundamental to its
field as the revolution in cosmology from a Newtonian view of space to an Einsteinian view
of space (Maddison and Pérez, 2000). Just as mass curves space, phylogeny has curved the
space of biological diversity, providing a distortion on the distribution of traits of organisms
we see around us. MacClade and Mesquite are both designed to provide a corrective lens, to
help us to see organisms and their traits in their natural orientation within this curved space
along the phylogeny. Mesquite's modularity allows this perspective to be extended to fields
such as morphometrics, in which a phylogenetic perspective has relatively recently begun to
suffuse the field.

Which to use, Mesquite or MacClade?

Version 4 of MacClade (Maddison & Maddison, 2000) was released in October 2000, and the
MacOS X compatible version 4.04 in July 2002. (It is now at version 4.08.) The reader might
wonder why we have been working on two different programming efforts, and whether they
are intended for different uses. Although Mesquite's extensibility means that it has many
more features than MacClade, MacClade has some features that Mesquite lacks. Calculations
and functions of MacClade's tree window not currently available in Mesquite include
particular charts (e.g., Changes and Stasis), equivocal cycling, the concentrated changes
test, some of the parsimony options (irreversible, stratigraphic, Dollo), a detailed Trace All
Changes mode, and some options for tree printing (e.g., saving a tree to the clipboard). For
some users the most significant advantages of MacClade 4 over MacClade 3 are in the data
editor, where editing of molecular sequences is more sophisticated, with better tools for
manual sequence alignment and on-the-fly translation to amino acids. We cannot predict
when these features will be available in Mesquite. MacClade also has a simpler interface,
which some users might prefer. We imagine that in the long-term future MacClade will give
way to Mesquite as Mesquite matures. For the next several years, however, the two will
coexist and be complementary.

References

Maddison, D.R. and W.P. Maddison. 2000. MacClade version 4: Analysis of phylogeny and
character evolution. Sinauer Associates, Sunderland Massachusetts.

Maddison, W.and T. Pérez, 2000. Biodiversidad y lecciones de la historia. In: Enfoques
gontemporéneos para el estudio de la biodiversidad [Hernandez, H.M., A. Garcia Aldrete, F.
Alvarez and M. Ulloa, editors]. Instituto de Biologia, UNAM, Mexico. Pp. 201-220.

file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/whyMesquite.html Page 4 of 4


http://www.macclade.org/

Mesquite installation for MacOS 23.10.2007 4:44 PM

Mesquite installation for MacOS X

(Please email us (info@mesquiteproject.org) with questions or comments about downloading Mesquite).

Instructions:

1. Download mesquite.dmg.
2. If the mesquite.dmg doesn't mount into a disk image automatically, double click it to mount. You will see a

Mesquite_Folder. Drag this Mesquite_Folder to your hard drive (e.g., your Applications folder). Its contents should
look like this:
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3. Double click one of the Mesquite icons to start Mesquite. We suggest you try first Mesquite OSX. This starts the
most current version of Java on your computer. The other versions start Java 1.4 or allocate more memory. You
might want to try these if you are having problems with the normal version. We recommend the most current
versions of OS X and Java.

4. You will also notice the file "Run_Mesquite_OSX.command". This contains the command needed to start
Mesquite as if from the command line. You can edit this command (using a text editor) to fine-tune the amount of
memory allocated to Mesquite, and perhaps to modify startup conditions.

5. To change the memory allocation of the "Mesquite OSX (hi-mem)" control-click (right click) on the application,
and from the drop down menu choose Show Package Contents. Inside, go to Contents/info.plist. Open this file with
a text editor, and in the line " <string>-Xmx512m -Djava.library.path=lib</string>" change the number 512 either
higher or lower (do not introduce spaces!).
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Requirements: OS X 10.4 or higher recommended; Java 1.4 or later.

NOTE: If you have a previous version of Mesquite installed in your system, we advise that you delete it before installing
the new version. Remember to save

More details of issues of using Mesquite under Mac OS X are described in the Support page.

Copyright © 2002-2007 W. & D. Maddison
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Mesquite installation for Windows

(Please email us (infO@mQSQUiteDrojeCt-Org) with questions or comments about downloading Mesquite).

NOTE: If you previously installed an older version of Mesquite, we recommend you delete the Mesquite_Folder directory before installing
the new version. First, however, you may want to take from Mesquite_Folder/mesquite any third party packages (e.g., PDAP, TreeSetViz)
before deleting the directory.

In order to run Mesquite, you must have Java 1.4 or newer installed on your computer. We recommend you install the latest version of Java
before installing Mesquite (java.sun.com). Java Standard Edition 5.0 is suitable (JRE 5.0).

Instructions:

1. Download the Mesquite Installer. There is also a special installer for a high-memory version of Mesquite here. You might want to use
the high memory version if you are using many trees, large trees, or large matrices.
2. Run the installer. It runs as a wizard. Once it is done, you should see a Mesquite folder something like this:
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3. The file "Mesquite" with the icon is the Mesquite executable. Double click this to start Mesquite.

4. You will notice a file called "Run_Mesquite_Windows.bat" in the Mesquite_Folder. This is a batch file that contains the command
line instruction to start Mesquite. If you double click this file, Mesquite will start. We include this file because you can modify the
command line to change how Mesquite runs when you double click the batch file. In particular, you can change the number "400", the
memory allocation, to higher numbers if you need more memory (don't introduce spaces!).

File and Folder Tasks

J Make a new folder

&8 Publish this folder to
the Web

4 Share this Folder

e

Other Places

{3 Program Files
.} My Documents
) Shared Documents

More details of issues of using Mesquite under Windows are described in the Support page.

Copyright 2002-2007 W. & D. Maddison
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Mesquite installation for UNIX/LINUX

(Please email us at info@mesquiteproject.org) with questions or comments about downloading
Mesquite).

Requirements: JRE or JDK 1.4 or better (java.sun.com). (It is best to get Sun's Java VM; Mesquite does not
run on some third-party virtual machines.) See notes on the support page, especially regarding issues with
window and dialog size and placement.

Instructions:
Download and decompress this file:
o .tgz file

It will create a directory called "Mesquite_Folder" in which all the relevant files reside. To start Mesquite,
execute the run_mesquite.sh script from the command line:

./run_mesquite.sh

This should automatically identify your java installation. If you have trouble, you may need to set your
JAVA_HOME environment variable. In the uncommon case that you want a java VM to run Mesquite that
is different from the VM identified in JAVA_HOME, you may set the MESQUITE_JAVA_HOME
environment variable.

Once Mesquite has finished loading, go to the File menu to open a file.

If the current user directory is not the Mesquite_Folder, and Mesquite has not been run before, Mesquite
may ask you to find the file "manual.html" which resides in the Mesquite_Folder/docs/mesquite/ directory.
This will help Mesquite find and remember where its files are.

If run_mesquite.sh fails

In the event that the shell script fails, it may still be posible to run Mesquite manually. The main class file is
mesquite.Mesquite. To start Mesquite you can use jre or java. For instance you could use:

java -cp /home/myuser/Mesquite Folder mesquite.Mesquite

where /home/myuser/Mesquite_Folder could be replaced by whatever is the path to the Mesquite_Folder.
On some systems the java virtual machine is started by "jre" instead of "java", and thus the command would
be:

jre -cp /home/myuser/Mesquite Folder mesquite.Mesquite
Depending on your configuration, you may need to give the explicit path to the java virtual machine, as in:

/usr/java/jrel.4.2/bin/java -cp /usr/local/Mesquite Folder mesquite.Mesquite
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If you've changed the name of Mesquite_Folder to, for instance, "Mesquite2", you may need to use a
command like:

/usr/java/jrel.4.2/bin/java -cp /usr/local/Mesquite2 mesquite.Mesquite

If you've had to do all this because the shell script isn't working, please let us know what happened, and
what you did to make Mesquite work. That way, we can make it easier for the next person.

Window Managers
Mesquite attempts to place windows in particular places on the screen for ease of use, using standard Java

calls. Some window managers override this, resulting in haphazard placement of windows. You may need to
change your window manager if this sort of thing is happening.

More details of issues of using Mesquite under Linux/UNIX are described in the Support page.

Copyright 2002-2006 W. & D. Maddison, T. Wheeler
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Basic concepts and vocabulary

Mesquite was designed to explore the evolution of organsims and their characteristics. Here
is some basic vocabulary that relates the biology to the implementation in Mesquite.

Taxa

e Taxon - One of the basic entities being studied, usually a species or a gene sequence.
In Mesquite (as in other programs), the word "Taxon" has shifted from its traditional
meaning to become more or less equivalent to "terminal taxon” (the smallest unit of
analysis of relationships).

¢ Block of taxa - A collection of taxa grouped together for analysis. In most programs
dealing with phylogeny, there is only a single block of taxa allowed in a file (e.g.,
"Primates”, consisting of 20 species of primates). In Mesquite, multiple blocks are
allowed (perhaps to study associations among them, in the style of Rod Page's
programs), and so it is useful to refer to different blocks of taxa. A block of taxa is
equivalent to a TAXA block in a NEXUS file.

e Group Membership (Taxa partition) - A subdivision of a taxa block into disjoint
subsets. Thus, a taxa block for Mammals may have its taxa partitioned into one of
three groups, Carnivore, Ominvore and Herbivore. A taxa partition is equivalent to a
TAXAPARTITION in a NEXUS file.

Characters

e Character - A variable or characteristic measured or observed for a block of taxa. It
could be from molecular data ("Nucleotide at position 367 of the 18S gene"), or it could
be phenotypic ("length of wing"). Characters in Mesquite typically exist only within
character matrices.

e Character model - a model of the evolution of a character. This could be a model for
use in parsimony calculations (e.g., "unordered”, a cost matrix) or in likelihood
calculations or stochastic simulations (e.g., HKY85, GTR).

e Character matrix - A matrix representing the character states of various characters for
a block of taxa. Each character matrix in Mesquite must be homogeneous with respect
to type of character (e.g. nucleotide sequences can't be intermingled with
morphometrics data).

e Character partition - A subdivision of a characters into disjoint subsets. Thus, a
character matrix for insects may have its characters partitioned into one of three
groups, larval, pupal, and adult. A character partition is equivalent to a
CHARPARTITION in a NEXUS file.

e Character inclusion set - A specification of what characters are to be included and
what excluded from analyses. This is equivalent (in inverse form) to an EXSET in a
NEXUS file.
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e Character weight set - A specification of what weights are to be applied to characters
in summed calculations (especially for parsimony calculations). This is equivalent to a
WTSET in a NEXUS file.

e Parsimony model set - A specification of what parsimony model of character evolution
(i.e., what "transformation type") is to be applied to each character of a matrix. This is
equivalent to a TYPESET in a NEXUS file.

e Probability model set - A specification of what probalistic model of character
evolution is to be applied to each character of a matrix.

Trees

e Tree - A tree representing the relationships of the taxa. If the taxa are species, the

tree represents phylogeny; if the taxa are gene sequences, the tree represents a gene
genealogy.

e Block of trees - A collection of trees. This might be a set of trees saved by the user,
or output by a program like PAUP*.
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Making, opening and saving data files

Mesquite is currently designed for data files following the NEXUS format (Maddison, D.R.,
D.L. Swofford, and W.P. Maddison. 1997. NEXUS: An extensible file format for systematic
information. Systematic Biology 46: 590-621) although it can import and export files of other
formats. Thus, you could create your data file with a text editor or word processor if you
followed NEXUS conventions. However, you'll probably find it easier to use Mesquite's data
matrix editors, tree windows, and so on, to specify the information in the data file, and let
Mesquite handle the formatting issues.

Mesquite can read NEXUS files created with MacClade, and can save files that MacClade
understands. For information on importing and exporting other formats, see the page on
using Mesquite with other programs.

Creating a new data file

To create a new blank data file, choose File>New (i.e., the New menu item in the File menu).
You'll be presented with a dialog box in which you enter the name of the set of taxa (e.g.,
“Drosophila”) the initial number of taxa, whether or not you want to show a tree window,
and whether to make a character data matrix. (The taxa could be species, or sequencies, or
whatever are your "terminal taxa", "Operational Taxonomic Units", or evolutionary units.)
(You can just leave the name of the set of taxa as "Untitled" if you wish, but that may
become confusing if you ever have more than one set of taxa in the same file.) You can
later add more taxa using (List of Taxa)List>Add Taxa Or (Character Matrix Editor)>Matrix>Add Taxa, Or by
using the Add Taxa tool in the Character Matrix editor.

When you make a new data file, you'll be presented with a list of taxa or perhaps a tree
window. The taxa are automatically named "taxon 1", "taxon 2", and so on. You can rename
a taxon name (e.g., "D. melanogaster”, "D. willistoni”, and so on) by selecting the |-beam
tool in the List of Taxa window and touching it on the taxon name. There is a submenu, (List
of Taxa)List>Alter Taxon Names>, that might offer other ways to edit taxon names. Taxon names
can also be edited in the Character Matrix editor, either manually or using the Taxon
Utilities and Taxon Names submenus of the Matrix menu.

A new data file does not automatically include a matrix of character data unless you request
it. To add new matrices, see the section on the Character Matrix editor.

Opening an existing data file

To open an existing data file, use File>Open>File. If Mesquite detects that the file is not a
NEXUS file, it will ask to you to choose its file format for importing.

Saving a data file

Save a data file using File>Save File Or File>Save File As. You can also export to other formats
using File>Export.

You can indicate that a character matrix should be written in the NEXUS file as INTERLEAVE


http://macclade.org/
file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/otherPrograms.html
file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/characters.html
file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/characters.html
file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/characters.html

Managing Files 23.10.2007 4:28 PM

(or not) by going to the Character Matrix Editor window and selecting the menu item
Matrix>Current Matrix>Write Interleaved

Projects and files

Mesquite is not restricted to considering only one file at a time, but instead can collect
information from various files and consider it together. Such a collection of files sharing
information is called a project. Implicitly when you first open a file, a project is created,
one which contains only a single file. Other files can be linked into the project using the
Link commands.

Since Mesquite can accumulate and analyze a more or less indefinitely large collection of
elements of information (several sets of taxa, data matrices, and so on), Mesquite doesn't
need to respect the boundaries of files. That is, it could read a TAXA block from one file on
the disk, and read a data matrix for those taxa from another file on disk, and a set of trees
from another file. While other programs can handle external treefiles or command files,
Mesquite can handle external character matrices, assumptions, and so on.

Mesquite therefore makes a distinction between the collection of elements of information
that are currently interacting with one another in Mesquite's calculations, and the physical
files on disk or server. The former collection, which may include information gathered from
several files, is called a project. The set of files to which the elements of information in a
project belong are said to be linked.

Mesquite shows a list of the projects and files currently active in the Projects and Files
window. In the example shown here, there are two projects currently open. The first,
marked by a sandy color, includes two linked files, "salticidae.nex” with a block of taxa and
"salticidTrees.nex" with trees. The second project, marked in blue, includes one file
“"carabidae.nex” with a block of taxa and a character matrix. The windows (tree windows,
data editors, etc.) belonging to these two projects will also be distinguished by these
different background colors. Information is not shared between projects, so that when you
are using the windows of "salticidae.nex”, the character matrix "185" will not be available for
use.
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Opening versus Including versus Linking files

In Mesquite there are three ways to read a file: Open, Include and Link.

1.

Open — If a file is to be opened up independently of any other open files, and not
share information, it should be opened using the Open File... menu item. A file opened
in this way is treated as belonging to a project separate from any other files open at
the time. In the graphic above, Open File... was called twice, once to open
salticidae.nex, second to open carabidae.nex.

Include — To read in the contents of a file and merge them into an existing file, so
that all of its information becomes part of the existing file and is saved into that
existing file, use the Include File... menu item.

Link — To read in the contents of a file and add its information to a collection of
information in a project in use, but to maintain the file separate for purposes of
writing to the disk, use the Link File... menu item in the File menu. A file opened in
this way will become part of the project. Because of the interdependencies among
elements of information that can exist (list of taxa in a data file matches list of taxa in
a tree file), it is possible that editing information that belongs to one file will also
change information in a linked file. In the graphic above, Link File... was called once,
to link salticidaeTrees.nex with salticidae.nex.
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Mesquite's menus

Mesquite's menus differ from window to window and vary depending on the calculations
being performed. In operating systems such as Windows and Linux, each window has its own
set of menus embedded at the top, thus making it easy for the user to understand the
context — a particular window — in which the menu item exists. Users of the Macintosh OS
will see the screen menu bar change depending on what window is at the forefront. On the
other hand, there is considerable duplication of menu items from window to window, which
reflects the fact that windows share context to varying degrees, but which may be confusing
to users of operating systems with window-specific menus. We will not here take sides about
which menu paradigm is better, but note that Mesquite's menu are firmly organized so as to
reflect the heirarchical structure of the calculations performed.

1. Learning about menus
2. Standard menu items
3. Where to find menu items

Learning about menus

Mesquite menus include a few constant ones (File, Edit, Window) and various other menus
that change as different modules are used. This situation could be confusing to the user. For
instance, menu items for particular modules may appear in different places depending on
the context.

Below is a list of the standard menu items that should appear in most configurations of
Mesquite. There will likely be other menus and menu items in addition to these.

Mesquite can automatically generate documentation for the current menu configuration and
present it to the user as a web page. This can be done by selecting the Menu & Control
Explanations menu item from the Window menu of Mesquite. Also, if you hold down the
Shift key while selecting a menu item, an explanation of the menu item will appear in the
explanation are of the foremost window.

Standard menu items
File

New — Make a new file (as a new project)
New Linked File — Make a new file (linked to the current project)
Open File... — Open file as a separate project (not linked to current project)
Open Other
o URL... — Get file from web server
e Link File...— Open file and incorporate into the current file (or home file of current
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project)
¢ Include File... — Open file as linked (and hence sharing information with) the indicated
project
Close File — Close the file
Close All — Close all projects
Close Window — Close the foremost window
Save File — Save the file to disk.
Save File As... — Save the file to disk under another name.
Get Info... — Shows what is the current file and its location.
Export... — Save the file to disk under another name and with a format other than
NEXUS.
Save Window As Text... — Save the text version of the window (visible by touching on
the Text tab of the window).
Print Window... — Print the foremost window.
Print Window to Fit Page... — Print the foremost window so as to fit within a page.
Save Window as PDF... — Save the foremost window as a PDF image.
Activate/Deactivate Packages — Change the configuration of modules loaded. These
menu items affect what modules, among those installed in your copy of Mesquite, are
actually loaded at startup. Most configurations load only a subset of menu items, for
instance to simplify the interface.
o Use All Installed modules— On next startup, load all installed modules
o Choose Configuration — Choose the configuration of module packages loaded at
next startup.
o Delete Configuration — Delete user-defined configurations
o Define Configuration — Define a new configuration of modules to be loaded at
startup
e Macros
o Show Macro List — Show list of Macros available, and where available
explanations as to what each does.
o Edit Macro Information — Change name and explanation for user-defined macros.
o Show Macro List — Show list of Macros available, and where available
explanations as to what each does.
e Rename Log file — Renames the current log file.
e Reset Menus — Forces rebuild of all menus. Useful on Windows because of a bug in the
Java virtual machine that occasionally scrambles menu names
¢ Force Quit — Forces Mesquite to quit without the usual clean-up and checking whether
the file has unsaved changes. Should be used only in emergency situations (e.g. if some
calculation appears to have crashed)
e Quit Mesquite — Quit Mesquite

Edit

¢ Undo — Minimally functional. Undos most recent change to tree in tree window. Not
available for Character Matrix Editor and other windows
e Cut, Copy, Paste — Have their standard uses, though currently only deal with text.

file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/menus.html Page 2 of 5



Menus

23.10.2007 4:28 PM

e Font — Change the default font for the foremost window.
e Font Size — Change the default font size for the foremost window.
e Add AUTHORS block to File — Adds an AUTHORS block to the file, important for

collaborative projects.

e New Generic Nexus Block — Make and edit a NEXUS block for the file.
e Edit Mesquite script — Edit a Mesquite script contained in the file
e Edit Comment — Edit the comment about the file.

Characters

e Character Matrix Editor » — Show a data editor for a character matrix

List of Characters » — Show the list of characters for a particular character data
matrix
New empty matrix... — Make a new, blank character data matrix

e Make New Matrix from » — Make a new character data matrix by copying an existing

matrix or filling the matrix from a special source (e.g., simulated characters)
o sources of matrices listed here

e List of Character Matrices — Show the list of available character data matrices
e List of Character Models — Show the list of available models of character evolution
e New Character Model... » — Make a new model of character evolution

o types of character models listed here

e Edit Character Model... » — Edit an existing model of character evolution
e Lists

o Parsimony model sets » — Show a list of the sets of assignments of parsimony
models for a particular character data matrix

o Probability model sets » — Show a list of the sets of assignments of probability
models for a particular character data matrix

o Character sets » — Show the character sets for a particular character data matrix

o Inclusion sets » — Show the character inclusions sets for a particular character
data matrix

o Character Partitions » — Show the character partitions for a particular character
data matrix

Taxa&Trees

New Tree Window » — Show a new tree window for a particular set of taxa (multiple
tree windows can be shown)

Current Tree Window P — Bring an existing tree window to the front

List of Taxa » — Show a list of taxa for a particular set of taxa

New Block of Taxa... — Make a new set of taxa

List of Taxa Blocks — Show a list of the different sets of taxa

List of Trees » — Show a list of trees in a tree block in the file

New Empty Block of Trees... — Make a new empty block in which to store trees
Make New Trees Block from — Make a new block of trees by copying an existing block
or filling the block from a special source (e.g., simulated trees)
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o available sources of trees listed here
List of Tree Blocks — Show a list of tree blocks in the project
Multi Tree Window — View several trees at once in window.
List of Taxa Partitions— Show a list of taxa partitions that exist
List of Taxon Sets— Show a list of the Taxon sets that exist

Analysis
e Menu items to make new charts and other analyses are listed here

Window

e Menu & Control Explanations — Causes Mesquite to compose a web page listing the
menu items currently in the menu bar for this window, and where available gives
explanations for what they do. Also lists the buttons currently in the window, and
where available gives explanations for what they do.

e Clone Window — Clones the foremost window. Useful to reproduce an existing analysis
then change it slightly. Cloned window will appear exactly above original window; thus
the clone should be moved to view the original.

e Save Window As Macro — Save foremost window as a macro. This macro can later be
used to reproduce the window's appearance and analyses.

e Macros — Execute the selected macro.

e Scripting — The "Show Snapshot” item displays the script that would be required to
return the foremost window to its current states; "Send Script” sends a script to the
foremost window.

e Bring All Windows To Front — Brings all Mesquite Windows to the front.

e Current Windows — Allows you to select current Mesquite windows to bring them to

the front.

Mesquite Startup Window — Makes the Mesquite startup window visible.

Mesquite log — Makes the Mesquite log window visible.

Mesquite Projects and Files — Makes the Mesquite projects and files window visible.

Display License — Shows the license under which Mesquite is distributed.

Help

e Mesquite Manual — Show home page of Mesquite manual

¢ Modules Loaded — Show web page of modules that are installed and loaded

e Keyword Search — Search for exact keyword among the names and explanations of
loaded modules.

Web Search — Search for exact keyword using the Google search engine.

Scripting Commands — Show web page of available commands for scripting

Active Module Tree — Show the entire employee tree of modules

List Active Modules — Write to the log a list of the entire employee tree of modules
List Prerelease Modules — Write to the log a list of any modules loaded that are
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labelled as prerelease and substantive
¢ Show Developer Statistics — Write to the log some information useful for debugging.

Where to find menu items

Other menus come and go depending on which window is in front and what calculations are
in use. Thus, the standard Tree Window has a Tree menu.

As the user requests calculations and output of results, the menus change. The reason for
this is that different menus are appropriate in different circumstances. Thus, if the user
requests the Balls and Sticks method to draw trees, a menu item "Spot size" appears in the
Tree menu. Spot size controls the size of the balls drawn at the nodes of the tree.

Exactly where a menu item appears may at first be confusing to the user, but there is a
certain logic to it that hopefully won't be too obscure (technical details are available in the
developer's documentation). The "Spot size" menu item belongs to the module that draws
trees in the Balls and Sticks fashion, since that module wants the user to be able to control
the size of the balls. That menu item appears within the menu of the modules that employ
it to draw trees. Since the Drawing menu belongs to the module that coordinates tree
drawing, and it is this module that (indirectly) is employing Balls and Sticks to draw the
tree, the menu items belonging to Balls and Sticks appear in the Drawing window.

A module can also have its own menu, as does the tree drawing coordinator. Thus, the menu
items of a module (usually) appear in the menu belonging to its closest employer module
that has its own menu. We say "closest” because sometimes a module will have a menu item,
but its immediate employer won't have a menu to put it in. The menu item drifts upward in
the employment hierarchy until it finds an employer that has a menu that can house it.

This system means that menu items appear in an appropriate context, but that that context
is not fixed because it depends on what employer has a menu in which the item can be
housed.

file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/menus.html Page 5 of 5


http://mesquiteproject.org/mesquite/development/development.html

Mesquite's Windows 23.10.2007 4:32 PM

Mesquite's Windows

With version 2 of Mesquite, separate windows can be bundled together as tabbed panels in the
same window. Because most of these panels can exist as separate windows, we will refer to them
as "windows" even though you may rarely see them as separate windows.

Some basic Mesquite windows are:

e Startup window - the colorful window with the mesquite leaf, the progress bar indicating
modules loading, and the banners at right for installed and loaded packages.

¢ Main Mesquite window - this has three panels, the Log Window, the Project and Files
Window, and the Search window. (See images below.) One important aspect of the Log
window is that it has the Defaults menu for changing some important preferences.
Tree Window - the window to view and edit trees
Character Matrix Editor - a spreadsheet editor for character matrices
List Windows - show lists of characters, taxa, trees, models and other objects.

Three panels of the main Mesquite window
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,,..> = a BN - Search Features
Cutrent Projects Authar Wayne Maddisos) ~
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matrix) in list window
L > ' Likelihood Surface AsymmMk Model: Shows
the likelihood surface for the AsymmMk Model
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On this page are explanations of the general features of windows, as well as issues specific to list
windows.

You can output a window by printing it, saving it as a PDF file, or saving a text version. To print a
window, select from the Print menu items in the File Menu. You can also save the window as a
PDF document using Save Window as PDF, or save it as text using Save Window as Text.

Common features of windows

Windows in Mesquite have a consistent structure, with these components commonly appearing:
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Here are brief descriptions of some of these:

Window Tabs
Information bar
Mini -scrolls
Tool palettes
Annotation area
Explanation area

Window Tabs

As noted above, windows can exist either separately or bundled within a single window as tabbed
panels. When bundled, the window will have a series of tabs at the top that permit you to choose
which panel (i.e., which window) you want to see:

i.” — — ]
Project of "15aa-xiphLikelihood.nex" 'Elly[Tree Window 5 showing Stored Trees Pg“ Character Matrix "phenotype” [&;J

The tab that shows dark is the current window shown.

Tabs can be closed using the I-EJ. By touch this you are asking the window represented by the tab
to be closed.
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Windows can be "popped out” as independent windows using the pop out button ( ). A popped
out window can be returned to being a tabbed panel within the project window using the pop in

button () at the upper left of the popped out window.

You can turn off window bundling by deselecting Open Windows as Tabs in the Defaults menu of
the Log window.

Window information bar

Windows can have an information bar that allows you to access information about the window, its
calculations, and the modules involved in them. If the information bar is not showing and you wish
to see it, select "Show Information bar" in the Window menu.

I /Graphicsy Text " Parameters'/Modules'/Citations

The tabs in the information bar choose the different modes of display of the window. The first
two of these (the graphics tab, and the text version tab), cause the window to display its basic
output (e.g., the spreadsheet data editor, the tree drawn in a tree window) in either a graphics
form or a textual form. The remaining tabs give information of other sorts.

The window modes are:

e Grapical version of output — The standard output of the window showing results and
analyses.

e Textual version of output — A textual version of the results and analyses.

e Parameters of modules — A list of the current settings and parameters of the modules
involved in producing the window and its contained results.

e Tree of Modules — Shows the employee tree of all modules participating in the window

e (Citations for modules — Gives citations for some of the modules participating in the
window.

Mini scrolls
Mini scrolls are used to scroll among trees, characters and other items. The small blue button
right of the text edit box, when hit, tells the scroll to enter and use the number within the edit

box. Otherwise you can use the arrows to scroll forward or back. If the change is not acceptable
(e.g., because you are already at the minimum or maximum value) the arrow is dimmed.

2
4P
Tool palettes

In various windows are tool palettes that look something like this:
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The button of the current tool is shown darker. Usually in the explanation area of the window, an
explanation is shown for a tool when you click on it. Some tools (whose buttons may show a small
inverted triangle) when double clicked, right-clicked or control-clicked, show a menu in which
options can be chosen.

Annotation area

The white annotation area shows footnotes or other annotations stored for taxa, trees, characters
or other objects. These annotations are sometimes editable. At its left are two buttons, a minus
and a plus arrow. These reduce and increase the height of the annotation area.

A® ’7
Explanation area

The explanation area, below the annotation area, shows explanations for tools, modules, objects
in files, and so on. Its height can be contolled by the minus and plus arrows.

List Windows

In the Characters and the Taxa&Trees menus are available various windows that give lists of
objects with information about each, including the List of Characters and the List of Taxa
Windows. Other List Windows present lists of tree blocks, taxa blocks, character matrices,
character models, parsimony model sets, and so on. These List Windows have a consistent
interface: you can select rows and columns, show and hide columns, and possibly rename and
delete objects.
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At left of the List Window is a tool palette. The arrow tool allows you to select columns or rows.
The I-beam tool allows you to edit the name of an object. The magic wand tool selects all rows
that have the same or similar value in the column touched. The magic wand tool has alternative
selection criteria that can be chosen by clicking and holding the cursor on the tool in the tool
palette. The sort tool reorders the objects listed according the column on which you touch. Thus,
if you touch on the leftmost column showing names, the objects would be sorted alphabetically. If
you touch on a column showing a numerical result, the objects are sorted in ascending or
descending order of the number. The sort tool sorts in ascending order by default, but by
descending order if the option or ALT key is held down.

Each List Window has a Columns menu, with which you can show or hide columns. Some columns
merely inform you of some quality of the object. Others may represent analyses. For instance, the
column may show the value of some statistic for each of the characters listed in the List of
Characters window.

For some of the List Windows, you can ask to delete the objects whose rows are selected by
choosing "Delete Selected” from the List menu.
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Mesquite's Charts

Charts compile and display values for a series of objects or items, whether taxa, trees,
characters, or matrices. Mesquite has two primary styles of charts:

e Bar & Line Charts - a bar or linechart summarizing values for each of many objects;
includes histograms to show frequencies of values. (Called "Histogram" in earlier
versions of Mesquite.)

e Scattergram - a plot showing each object's value in two variables

Most of Mesquite's charts are available through the first few submenus of the Analysis menu.

We suspect the greatest challenge to the user will be learning what chart to choose and how
to set it up. For instance, how can one create a chart summarizing the estimated rate of a
character's evolution according to each of a series of trees? Does one choose New Bar & Line
Chart For>Characters because the value concerns a character? No, one chooses New Bar & Line
Chart For>Trees because the numerous objects being summarized are trees, as the question
concerns just one character but many trees. For each tree, what is being calculated is a
value that relates to a character.

Contents

Chart Wizard

Selection of objects in charts

Auto-recalculation

Bar & Line Charts
o Example: Robustness of estimated bias in character evolution
o Example: Compositional bias along a sequence
o Calculating and formatting options

Scattergrams
o Example: Canonical Variates Analysis
o Example: Correlation between variability and hydrophobicity
o (Calculating and formatting options

Chart Wizard

The first item in the Analysis window, Chart Wizard, helps you make charts. It asks you a
series of questions to determine what type of chart you want. We provide this because it is
sometimes difficult to decide how to start building a chart. Alternatively, you can use the
New Bar & Line Chart for and New Scattergram for submenus to build a chart.

Selection of objects in charts
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Most bar & line charts and scattergrams depict the values of objects— characters, taxa,
trees — that can be selected. If you select these objects elsewhere in Mesquite, for example
by selecting a column (character) in the Character Matrix Editor, then this selected objects
will be highlighted in the chart. You can select the objects directly in the chart by clicking
and dragging with the arrow cursor.

When objects are selected in the chart, and Copy is selected, then a list of the selected
data points is copied to the clipboard. Otherwise if no objects are selected, then Copy puts
the list of all data points into the clipboard.

Auto-recalculation

By default, charts are recalculated whenever Mesquite detects that the data or assumptions
underlying the chart have changed. If the chart calculation takes a long time, then this can
lead to many delays if you need to make many changes in the data or assumptions. You can
temporarily turn off the automatic chart recalculation by deselecting the Auto-recalculate
menu item in the Chart or Scattergram menu. You can also request to Force Recalculation in
the Chart menu.

Bar & Line Charts

The bar & line charts available via the Analysis menu are:

e Characters — the items whose values are summarized are characters. These could be
all of the characters of a matrix, or a series of simulated or randomized characters.

e Character Matrices — the items whose values are summarized are whole character
matrices. These could be all of the matrices stored in a file, or a series of simulated or
randomized matrices.

e Taxa — the items whose values are summarized are taxa within a taxa block.

e Tree blocks —the items whose values are summarized are blocks of multiple trees.
That is, each item is a block of several trees. These could be all of the tree blocks
stored in a file, or a series of simulated or randomized tree blocks.

e Trees — the items whose values are summarized are trees. These could be all of the
trees within a tree block, or a series of simulated or randomized trees.

Tables as output

In addition to the graphical chart, you can obtain a text table representation of the chart in
several ways:

e Select Copy in the Edit menu of the chart to copy a list of point values to the
clipboard; you can then copy it in to your favorite text or spreadsheet program

e Select Save Window as Text from the File menu to save a full text representation of
the chart

e |If Record Table to File in the Chart menu is selected, then a text file of the results
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will be saved each time a chart is recalculated. This is particularly useful for some
calculations that result in more than just a single value per item charted; in this case
you will be asked when you start the chart whether you want to save the record.

Examples

Robustness of estimated bias in character evolution — Suppose a biologist estimated the
bias in the rates of gains versus losses in a character's evolution on a given tree. How might
the estimate depend on accuracy of the tree's branch lengths? To answer this, one could see
how the estimate varies when noise is added to the branch lengths of the given tree. First
have a tree window available with the given tree showing. Then:

Select the menu item Analysis>New Bar & Line Chart For>Trees

e A dialog box with heading "Source of trees (Trees chart)" should appear. Choose

Randomly Modify Current Tree.

In the dialog box "Random modifier of tree”, choose Add Noise to branch lengths. You
will then be asked to indicate the variance of the noise, and the number of trees to
chart.

In the dialog box "Value to calculate for trees” should appear. Choose Tree Value using
character, because the desired value depends on the tree and a character.

In the dialog box "Value to calculate for tree with character”, ask to show secondary
choices then choose Forward/Backward rates

In the dialog box "Source of characters (for Forward/Backward rates)”, choose Stored
Characters (presuming you already have your character of interest entered in a data
matrix).

You may be asked other questions, depending on whether you data file includes
multiple matrices. Then, a chart should appear to answer your query. (The calculation
may take while.)

Compositional bias along a sequence — A biologist with DNA sequence data wants to see
how the relative frequences of A, C, G and T vary along the length of the sequence. To see

this:

e Select the menu item Analysis>New Bar & Line Chart For>Characters

In the dialog asking for a source of characters, choose Stored Characters (assuming
you have your DNA matrix in the file).

In the dialog "Value to calculate for characters (for Character Values Chart)", ask to
show secondary choices then choose Character Compositional Bias

The chart may initially appear uninteresting, but adjust as follows:

o Select Chart>Orientation>Values (Y) by Items (X) to cause the chart to show the
characters lined up, in sequence, along the X axis.

o The chart will probably be set to automatically group into categories along the X
axis. Try a moving window analysis by selecting Chart>Grouping on X>Moving Window...,
and indicating the width of the moving window and the offset between adjacent
window positions. The defaults are 5 and 1 respectively, but you could also try 10
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Above is an example of how the chart may appear. Some sections of the chart are red
because those characters were indicated as belonging to a distinct character group or
partition. In this chart, the introns (marked in red) have a stronger AT bias.

Calculation and Formatting options

The following menu items can be found in the Chart menu:

e Orientation

(o]

Number of Items (Y) by Values (X) — This is the typical "histogram” where the
vertical axis shows how many items have the various values arrayed along the X
axis. Thus, the X axis represents the value, the Y axis the number of items.
Value (Y) by Items (X) — This displays the data with items arrayed in sequence
along the X axis, and the Y axis representing the value for each item. This may
be appropriate for items, like characters (sites in a DNA sequence), which have a
natural ordering to them.

e Grouping on X — The X axis may be grouped into categories, such that the values
falling within a range on the X axis are summarized in a single bar. This submenu
controls any grouping.

(¢]

(@]

(¢]

Automatic — Mesquite chooses automatically how to group on the X axis

No grouping — The X axis is not grouped, and thus each item or object (each
character, tree, etc.) is represented by a separate bar.

Fixed number of groups — The X axis is divided into a specified number of
groups.

o Fixed Group width — The X axis is divided into groups of a chosen width.
o Moving Window — The X axis is divided into overlapping groups of a chosen

width. This serves to smooth the chart by averaging over adjacent values. There
are two parameters to set: the width of the moving window, and its increment.
The increment is the offset between the starting edge of adjacent moving
window positions.

¢ Analysis — In this submenu could be various analytical tools. Two standard choices are
Display Mean and Percentiles..., which display the mean value and tails of the
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distribution.

e Show Average For Group — When the chart is in the orientation Values by Items, and
there is grouping along the X axis, then each bar may represent several objects
(characters, etc.). This menu item allows you to choose whether the Y axis should
show the sum of the values of those objects, or their average value.

¢ Show Individual Points in Text — When the chart has grouping along the X axis, then
the text view of the window by default hows sums or averages of the groups. If instead
you want the text view to give all of the values for the original objects shown by the
chart, then select this menu item.

e Show as Bar Chart — By default, the chart is shown as a bar chart. However, if this
option is turned off, the chart will be shown as a series of dots connected by a thin
line.

e Cumulative Mode — By default, the chart is not shown in Cumulative mode. However,
by choosing items in the Cumulative submenu of the chart, Mesquite will present the
cumulative values at each point:

o Off — Not cumulative

o Simple Cumulative — The value of each item is the sum of the values of all
previous items

o Average Cumulative — The value of each item is the average of the values of all
previous items

o Reverse Simple Cumulative — The value of each item is the sum of the values of
all following items

o Reverse Average Cumulative — The value of each item is the average of the
values of all following items

Scattergrams

The scattergrams available in the Analysis menu are:

e Characters — each point in the plot represents a character. These could be all of the
characters of a matrix, or a series of simulated or randomized characters.

e Taxa — each point in the plot represents a taxon within a taxa block.

e Trees — each point in the plot represents a tree. These could be all of the trees within
a tree block, or a series of simulated or randomized trees.

¢ Nodes (Available under New Chart for Tree when a tree window is foremost) — each
point in the plot represents a node in the tree of the tree window.

These scattergrams show the values of two variables for the objects of concern. For some
scattergrams, a choice is given as to whether the Same or Different calculations should be
shown on the two axes. By "Same” is meant that the same calculation is done but with a
different parameter value. For instance, if the scattegram is a Taxa scattergram, it could
show the character state in continuous character 1 on the Y axis, and the state in character
2 on the X axis. These represent the same calculation (continuous character state value),
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differing only in the character used. By "Different” is meant an entirely different calculation,
such as the asymmetry of a tree on the Y axis and its likelihood score for a character on the
X axis.

Examples

Canonical Variates Analysis — For a sample of specimens measured for a series of variables,
how can the measurements be combined to best distinguish predefined groups? Multivariate
analyses such as these can be done using modules in the Rhetenor package. Each specimen
will be treated as a taxon. A continuous data matrix of the measurements should first be
entered, and the taxa be assigned to groups. Next:

e Select Analysis>New Scattergram For>Taxa

¢ |n response to the query about same or different calculations, chose Same

e |f asked, indicate you want to value for taxa to be Continuous States of Taxon.
Otherwise, in response to the dialog box "Source of characters (for Continuous States
of Taxon)", ask to show secondary choices and choose "Characters from Ordinations”.

¢ |n the dialog box "Source of matrices to be ordinated", select Stored Matrices.

¢ |n the dialog box "Ordination (for Characer Source)”, select Canonical Variates
Analysis. (You may need to ask for secondary choices)

Correlation between variability and hydrophobicity — Do amino acid positions in proteins
tend to evolve more quickly or more slowly depending on how hydrophobic they typically
are? Mesquite does not yet have direct way to estimate rate for protein characters, but we
can approximately compare relative rates by comparing the number of parsimony steps for
characters on a tree. First, begin with a file containing a protein data matrix and an open
tree window showing a tree. Next:

e Select Analysis>New Scattergram For>Characters

¢ |n the dialog box "Source of characters (For Characters scattergram)” choose Stored
Characters.

¢ |n response to the query about same or different calculations, chose Different

e On the X axis we will put hydrophobicity. Thus, in the dialog box "Values for X axis",
ask for secondary choices and choose Protein Site Property.

¢ |n the dialog box "Property of Amino Acid" choose Kyte & Doolittle Hydrophobicity.

¢ In the dialog box "Values for Y axis”, choose Character Value with Current Tree. In
the dialog box "Value to calculate for character” chose Parsimony Character Steps.
Indicate you want Current Parsimony Models to be used in the parsimony calculations.

The following scattergram shows the results of such an analysis, with two additions. First,
the dots are colored by a third variable, the mean molecular weight of amino acids at that
site. This can be done by selecting Color by Third Value from the Color menu, and in the
dialog box "Values by which to color spots in the scattergram” asking for secondary choices.
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Second, the analysis assistant Scattergram Regression Diagnostics (part of the PDAP package)
is in use, and shows the regression line. The text view of the window shows the details of
the analysis. The correlation is highly significant.

Calculating and formatting options

The following menu items can be found in the Scattergram menu:

e Marker Size — allows you to choose the size of the dots of the scatterplot
e Analysis — In this submenu could be various analytical tools. For instance, if PDAP is
installed, you can request regression and correlation analysis under
Scattergram>Analysis>Other Choices.
e Special Effects
o Show Density — this shades the background of the chart according to the density
of points. To see this, you may want to turn off "Show dots" (see below). Here is
an example:
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o Join the Dots, Join Last to First, Thick Joints — These control whether and how
a line is drawn between dots of the scattergram. These options are used to
indicate molecular structure as in the cytochrome B example in
Mesquite_Folder/examples/Molecular/06-cytochromeB.nex
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o Show dots — determines whether or not the dots representing objects in the
scatterplot are drawn individually

In addition, if the scattergram is of characters, a Color menu will appear that allows you to
color the dots according to a third value of the characters.
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Scripting and Macros

Mesquite’s scripting system allows modules and other objects to be scripted using text
commands. Mesquite uses scripting by text commands as follows:

e When a menu item, button, or tool is used, Mesquite sends a text command to the
appropriate object, informing it of the use. This means that most user interface
commands can also be executed in scripts and macros.

e When Mesquite re-reads a NEXUS file, it attempts to return windows and analyses to
approximately the same condition as when the file had been saved. It does this by reading
scripting instructions in a MESQUITE block that Mesquite had written into the file when
saved. Thus, Mesquite writes scripts called "Snapshots” to later instruct itself.

e Macros are script files which, if placed in the recognized directories, appear in submenus
as selectable menu items. When selected, the macro is executed. Mesquite recognizes
directories called "macros” within the Mesquite_Folder directory and the "Mesquite_Prefs"
subdirectory of the Mesquite_Support_Files directory.

e Not all scripts in MESQUITE blocks need to be written by Mesquite. Users can write
MESQUITE block scripts by hand.

e Users can send a script to a window using Window>Scripting>Send Script. This page gives some
simple examples for the tree window.

The text commands are sent to modules or other objects. The particular text commands to
which a module or other object responds will depend on the object. When Mesquite shows a
web page for the first time, it attempts to compile automatically documentation for scripting
commands that is available. This includes commands predefined by the scripting language, and
commands belonging to particular modules. This compiled documentation is available from the
web page linked from the "Scripting Commands” menu item in the Help menu when Mesquite is
running.

Mesquite's scripting language is not as human-friendly as it might be at present, especially in its
handling of variables and aspects such as the lack of "else” statements. Since the vast majority
of Mesquite scripts won't be written by humans but by Mesquite itself, that is not such a
liability as it might seem. We hope to reform the scripting language in the future.

Macros

Scripts performing some special function can be written and distributed by programmers to end
users as "Macros”. For some calculations or display functions, the number of different analyses
a user might like to do are too many to be easily supported by a graphical user interface. For
instance, the user might like to print the ancestral state reconstruction of a character using a
series of different stepmatrices. One can invent many such scenarios in which something
repetitious is needed, and a module would be hard-pressed to maintain each as an option.
Thus, small scripts using Mesquite's scripting language can be written and placed in the
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“macros” folder. These macros will appear as options in an appropriate place, depending upon
where they are applicable. When the user selects the menu item, the script is executed.

Macros can also be automatically composed by Mesquite. As noted above, Mesquite composes a
script to place in NEXUS files that it saves. This script applies only to the particular saved file.
In some contexts, you can ask Mesquite to save a script as a macro file. This is currently
available in only a few contexts. Save Window as Macro in the Analysis menu and Window menu
save macros that attempt to reproduce the condition (including analyses) of the foremost
window. This is useful to reproduce a complex chart with a different data file, for example.
Save Macro For Tree Drawing in the Drawing menu of a Tree Window creates a macro by which
you can later reproduce the current appearance of the tree drawing (background color, font,
tree form, orientation, and so on). Save Tree Analysis As Macro in the Tree menu of a Tree
window creates a macro by which to reproduce a particular analysis with the tree. Macros so
created are stored in Mesquite_Support_Files/Mesquite_Prefs/macros, and could be (for
instance) shared by users.

Learning about scripting

Users can learn about the scripting language from this web page, but also by inspection of
existing scripts. Some sources of scripts to examine are:

e The MESQUITE block within NEXUS files saved by Mesquite. If you want to know how to
script a tree window to trace a character, for instance, open a tree window, turn on
character tracing, and save the file. You can look at the file with a text editing program
to see how such a script would be written

e |f there are any macros installed, you can examine the files that specify them. These
files are simple text files with scripts. Macros would be found in folders called "macros”
within the Mesquite_Folder directory, and in the macros folder of the "Mesquite_Prefs”
directory of the Mesquite_Support_Files directory.

e The menu item Windows>Scripting>Show Snapshot shows a snapshot for the window — the script
that would be needed to set the window to its current state.

Another way to learn about the language and particular scripting commands is to look at the
web pages linked from the "Scripting Commands” menu item in the Help menu when Mesquite
is running. In particular, examine the page on universal commands, which shows basic
commands available regardless of the object being scripted, including the basic flow control
and variable-defining commands of the system. (We cannot provide a link here to this web
page because this web page is created by Mesquite when it runs, and is placed in a location
that depends on your particular computer. After running Mesquite once, you may want to find
some of these files and save a bookmark/alias/shortcut to them — the file on basic scripting
commands is named ‘puppeteer.html’).

Commands within scripts

In general, a command found within a script takes the following form:

file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/scripting.html Page 2 of 8



Scripting and Macros 23.10.2007 4:29 PM

commandName argumentl argument2 ...;

The commandName is a single word (token); the arguments can be multiple tokens, so long as
the module knows how to interpret them. Typically each argument is a single token (though
this may be string of multiple tokens converted to a single token by quotation).

Scripts

A script consists of a series of commands. At each stage in the script, there is an implicit
recipient of the command given (for instance, a module or a window). For instance, here is a
script within the MESQUITE block of a NEXUS file. To the right of the commands are comments
to explain them.

Begin MESQUITE;

getNumberOfDataSets; [file coordinator queried for number of data sets]

Integer.dataSets *it; [storing number of data sets in integer variable 'dataSets']

getEmployee 'Data Window Coordinator'; [querying for reference to Data Window Coordinator module]

tell It; [commands to follow will be sent to the Data Window Coordinator]
Integer.dataNum 0; [Define integer variable 'dataNum' and assign it 0]

for *Integer.dataSets; [for loop; cycle as many times as there are data sets]
showDataWindow *Integer.dataNum; [commands to make a data window for dataset]

tell It; [commands to follow will be sent to module that makes data window]
showWindow; [tells the module to make the data window visible]
endTell; [finished sending commands to the module that makes the data window]
increment.dataNum; [add 1 to the variable 'dataNum']
endFor; [end of the for loop]
endTell; [finished sending commands to the Data Window Coordinator]
getNumberOfTaxas; [file coordinator queried for number of sets of taxa]
Integer.taxaSets *it; [storing number of sets of taxa in integer variable 'taxaSets']
getEmployee 'Tree Window Coordinator'; [querying for reference to Tree Window Coordinator module]
tell It; [commands to follow will be sent to the Tree Window Coordinator]
Integer.taxaNum 0; [Define integer variable 'taxaNum' and assign it 0]

for *Integer.taxaSets; [for loop; cycle as many times as there are sets of taxa]
makeTreeWindow *Integer.taxaNum; [commands to make a tree window for set of taxa]

tell It; [commands to follow will be sent to module that makes tree window]
getTreeWindow; [queries the module to return a reference to the tree window itself]
tell It; [commands to follow will be sent to the tree window]

newAssistant 'Trace Character History'; [the tree window is asked to hire a module]

endTell; [finished sending commands to the tree window]
showWindow; [tells the module to make the tree window visible]

endTell; [finished sending commands to the module that makes the tree window]

increment.taxaNum; [add 1 to the variable 'taxaNum']

endFor; [end of the for loop]
endTell; [finished sending commands to the Tree Window Coordinator]

END;

This MESQUITE block causes Mesquite to show a data window for each of the data sets, and a
tree window for each of the Taxa blocks; the tree windows are shown with a character traced.

This script illustrates some of the features of Mesquite's scripting language:

e There is a current object to which commands are sent. Which object is being
commanded can be changed by a "tell” command. Initially, the implicit recipient of the
commands is the FileCoordinator of the file in question.

e Any given command may return an object that is stored within the variable referred to
by "It". Thus, in the above script, the makeTreeWindow returns the module hired to
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supervise the tree window. The immediately following command, "tell It" thus shifts the
recipient of commands to this tree window module.

e The scripting language has variables. They are defined or their values set by commands
beginning, for instance, Integer.mylntegerName or Object.myObjectName. Their values
can be utilized by prefixing their names by an asterisk, for instance
*Integer.mylntegerName.

e The scripting language has control flow, including if, for loops, and while loops.

Some of the lines of this script are commands unique to particular commandable objects
(getNumberDataSets, getEmployee, showDataWindow, etc.); others are predefined by the
scripting language (e.g., Integer, tell, for). More details on particular commands can be found
in the web pages linked from the "Scripting Commands” menu item in the Help menu when
Mesquite is running. Some details are found below.

Variables: Integers, Strings and Objects

Three sorts of variables are supported. Reference to each requires the type of variable with
name appended, as in "Integer.numberOfCharacters” or "Object.treeDrawCoordinator”. The
generic variable "it" refers to the object last returned by a command.

When the variable is passed as an argument for a command, it should be preceeded by an
asterisk. This allows the system to know that a variable, and not a constant string, is being
passeed.

Numerical variables

Two sorts of numerical variables are supported: Integer and Number. The former contain whole
numbers. The latter can contain whole or decimal numbers. Reference to each requires the
type of variable with name appended, as in "Integer.numberOfCharacters” or
"Object.treeDrawCoordinator”. The generic variable "it" refers to the object last returned by a
command.

When the variable is passed as an argument for a command, it should be preceeded by an
asterisk. This allows the system to know that a variable, and not a constant string, is being
passeed. The commands concerning variables are:

¢ Integer.[name] [number];— this declares an integer variable of name "name” and assigns
it the value given by the number. If the variable already exists, its value is replaced by
the number. The number may be represented by a constant, as in "Integer.counter 5", by
an integer variable, as in "Integer.counter *Integer.previousCount”, or by a String variable
that contains a string that can be parsed into an integer, as in "Integer.counter
*String.countString”. If the number is indicated as "random”, a random integer will be
placed in the variable.

¢ increment.[name of integer]; — this adds one to the integer's value

e decrement.[name of integer]; —this subtracts one from the integer's value.

file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/scripting.html Page 4 of 8



Scripting and Macros 23.10.2007 4:29 PM

e Number.[name] [number];— this declares a numerical variable of name "name” and
assigns it the value given by the number. If the variable already exists, its value is
replaced by the number. The number may be represented by a constant, as in
"Number.rate 0.5", by an integer variable, as in "Number.rate *“Number.previousRate", or
by a String variable that contains a string that can be parsed into a number, as in
“Number.rate *String.rateString”. If the number is indicated as "random”, a random
number between 0 and 1 will be placed in the variable. If the number to be placed into
the Number variable is preceeded by a '+, the number doesn't replace the existing value
of the Number variable, but is added to it (similarly for '-').

String variables

One sort of variable contains a string of text. The command to define and assign values to a
string variable is:

e String.[name] [string]; — this declares a String variable of hame "name” and assigns it
the value given by the string. If the variable already exists, its value is replaced by the
string, unless the string passed to it is preceded by "+" in which case it is appended to the
existing string. The string passed may be represented by a literal string, as in
"String.name John A. MacDonald", by an String variable, as in "String.name
*String.name.firstPM", or by an Object variable, in which case the name of the Object will
be used.

Object variables

One sort of variable contains a objects (such as modules, or windows). The command to define
and assign values to an object variable is:

e Object.[name] [reference to object]; — this declares an Object variable and assigns it
the object indicated. If the variable already exists, its value is replaced. The reference
may be "it", as in "Object.thisModule *It", or an Object variable, as in "Object.thisModule
*Object.storedModule”.

The variable "It"

Standard Mesquite Commands to modules return an object. In the scripting language, this
returned object is stored in the variable "It". Thus, after a command "getNumberDataSets" to
the FileCoordinator, the FileCoordinator returns an Integer variable containing the number of
data sets. This can be stored in an Integer variable by following the command by
“Integer.numDataSets *it". Likewise, "tell” often makes use of "it".

Flow and command control

As noted above Mesquite's scripting language has flow control as well as control of the object
to be commanded.
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Using "tell" to direct commands

Commands are directed toward commandable objects, including modules, windows, and others.
Since different objects might use the same command names, the object to which a command is
directed must be indicated. In the scripting language, at any point there is an implicit object
being commanded. Subsequent commands are directed to a different object using the "tell”
command, which must be balanced by "endTell". At the root level, the FileCoordinator is being
commanded.

Flow control

Flow control statements include "if", "for", and "while". Others are available (such as ifnot,
stop, exitTell). Details on these can be found via the web page shown by selecting Scripting
Commands from the Help menu while Mesquite is running.

e if [integer or integer variable]; ... endIf; — the statements between if and endIf are
executed if the integer variable is non-zero

e for [integer or integer variable]; ... endFor; — the statements between for and endFor
are executed as many times as the initial value of the integer variable.

e while [integer or integer variable]; ... endWhile; — the statements between while and
endWhile are executed repeatedly as long as the value of the integer variable is non-
zero.

Debugging

There are a number of commands that are useful for debugging. For instance, if the Command
"debug” is placed in the block, a debugging mode will be enabled which reports in the console
more details about the commands as they are executed. More information about such
commands can be found by selecting the "Scripting Commands” menu item under the Help
menu when Mesquite is running.

Examples

Here are three simple example scripts that you can send to the Tree window using
Window>Scripting>Send Script. Open a tree window, turn on Trace Character History, and then
paste one of these scripts into the Send Script dialog box. The first script scrolls from tree to
tree, for each recording in a file "results.txt” the reconstruction of ancestral states.

String.resultsFile 'results.txt';
saveMessageToFile *String.resultsFile 'RESULTS with different trees';
appendReturnToFile *String.resultsFile;
getWindow;
tell It;
getNumTrees;
Integer.numReps *It;
ifNotCombinable *Integer.numReps;
Integer.numReps 10; [in case indefinite number of trees]
endIf;
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endTell;

Integer.count 0;

for *Integer.numReps;
increment.count;
getWindow;

tell It;
setTreeNumber *Integer.count;
endTell;
getEmployee #mesquite.ancstates.RecAncestralStates.RecAncestralStates;
tell It;
getLastResult;
String.result *It;
appendMessageToFile *String.resultsFile *String.result;
appendReturnToFile *String.resultsFile;
endTell;

endFor;

This second script scrolls from character to character, for each recording the ancestral
states in a file "results.txt":

String.resultsFile 'results.txt';

saveMessageToFile *String.resultsFile 'RESULTS with different characters';
appendReturnToFile *String.resultsFile;

getEmployee #mesquite.ancstates.RecAncestralStates.RecAncestralStates;

tell It;
getNumHistories;
Integer.numReps *It;
ifNotCombinable *Integer.numReps;
Integer.numReps 10; [in case indefinite number of characters]
endIf;
endTell;

Integer.count 0;
for *Integer.numReps;
increment.count;
getEmployee #mesquite.ancstates.TraceCharacterHistory.TraceCharacterHistory;

tell It;
setCharacter *Integer.count;
endTell;
getEmployee #mesquite.ancstates.RecAncestralStates.RecAncestralStates;
tell It;
getLastResult;
String.result *It;
appendMessageToFile *String.resultsFile *String.result;
appendReturnToFile *String.resultsFile;
endTell;

endFor;
The third script scrolls from tree to tree, printing each one.

getWindow;
tell It;
getNumTrees;
Integer.numReps *It;
ifNotCombinable *Integer.numReps;
Integer.numReps 10; [in case indefinite number of trees]
endIf;
endTell;
for *Integer.numReps;
getWindow;
tell It;
setTreeNumber *Integer.count;
printToFit;
endTell;
endFor;

file:///Users/wmaddisn/Mesquite_Workspace/Mesquite%20Project/Resources/docs/mesquite/scripting.html Page 7 of 8



Scripting and Macros 23.10.2007 4:29 PM
Technical Details

(See the developer's documentation.) The Puppeteer is in charge of defining the basic language
as it relates to variables and flow control. For an object to be scriptable, it must be of the
Commandable interface. Commands internally in Mesquite are remembered in objects called
MesquiteCommands.
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Managing modules

If you are installing third party modules, you may want to go first to the explanation of possible
places to install the modules. There is a complete list of modules in the current version of
Mesquite; this may be useful for searches to find whether a feature exists in Mesquite.

Users will be able to use Mesquite more effectively if they become familar with the concepts of
modules and how they interact. An understanding of the modular system will help the user more
effectively give commands to Mesquite via menus and scripting, and interpret the results
obtained.

The page on how Mesquite works introduces modules and how they cooperate. In brief, modules
link together to perform calculations and display the results to the user. The linkage of modules is
in the form of a tree, with the root module being the "trunk” Mesquite module itself. Which
modules are currently active depends on the files the program has read and the calculations the
user has requested.

Installed versus loaded versus running modules

An installed module is one available to be used: it is sitting as a file or a series of files on your
disk or web server. Mesquite can find these modules and, if approprate, can get them started up.
Among the installed modules might be some that you never use, because you don't happen to
need their calculations.

Not all installed modules are available to a user during a Mesquite run. The reason is that,
although a module might be physically installed, it might not be loaded by Mesquite at startup.
An installed module might not be loaded if, for instance, the user has chosen a configuration to
control the loaded packages (see Activate/Deactivate Packages in the File manue). The
configuration file might indicate that only some of the packages are to be loaded and available.

When Mesquite starts up, or when the user requests new windows, calculations, and so on, some
of the loaded modules are started up to do the work. These are the running modules.

This characterization is a bit misleading, however, since many active copies of a single module on
disk can be running at once. That is, the installed module on disk can be thought of as a blueprint
for a machine, and each time Mesquite needs to start up a module, the machine is built and
started. If Mesquite needs another machine of the same sort, it can build a new one from the
blueprint. Many machines (running modules) from a single blueprint (loaded module) can be built
and be running simultaneously.

(To the programmer, the loaded modules are the available classes that are subclasses of the basic
module class; an active module is an object instantiated from one of these classes.)

Where modules are installed
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To be installed and found by the Mesquite system, a module must be within one of four places.
We will describe each under the assumption that a package "mypackage” with a single module
"MyModule" is being installed.

e the mesquite directory of Mesquite_Folder: this is the primary location for modules. This is
the only location modules can be located for use on Mac OS 9. If installed here, our example
module would be at: Mesquite_Folder/mesquite/mypackage/MyModule/MyModule.class

¢ in Mesquite_Folder/additionalMesquiteModules/mesquite: this is an optional location for
modules. If you are installing 3rd party modules, you might want to install them here, so
that you can easily find them again and reinstall them when you upgrade to a newer version
of Mesquite. If installed here, our example module would be at:
Mesquite_Folder/additionalMesquiteModules/mesquite/mypackage/MyModule/MyModule.class

¢ in Mesquite_Support_Files/classes/mesquite: this is an optional location for modules. It
can be useful for users who don't have permission to modify the main Mesquite_Folder but
may want to install new modules. If installed here, our example module would be at:
Mesquite_Support_Files/classes/mesquite/ mypackage/MyModule/MyModule.class

¢ at the locations specified in Mesquite_Folder/classpaths.xml. This file should have a format
as follows:

<?xml version="1.0"?2>

<mesquite>
<classpath>../MyExtraModules</classpath>

</mesquite>

This tells Mesquite to look outside of Mesquite_Folder, and inside MyExtraModules for the
root of the classpath. If installed here, our example module would be at:
MyExtraModules/mesquite/mypackage/MyModule/MyModule.class.

Furthermore, the active configuration must specify that the module's package be loaded. By
default, all installed packages are loaded.

Thus, if you open up the Mesquite_Folder, you might see the following

com
corejava
docs
documentation.html
edu
examples
images
Jama
JSci
lesser.txt
pal
mesquite. In this directory, you might see:
o ancstates
© assoc
o basic
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batchArch
categ
charMatrices
charts
coalesce
configs
cont
distance
genesis

io

jama

jsci

lib

lists
Mesquite.class
minimal
molec
ornamental
pairwise
pal
parsimony
rhetenor
search
stochchar
treefarm
trees

trunk

O 0O O 0O O 0O 0O OOO O 0O O OO OOOOO OO O O o o o

Each of the items in bold above is a directory (folder) that contains modules. Within minimal, you
might see:

= BasicFileCoordinator
= Defaults

= DrawHierarchy

= |nterpretNEXUS

= ManageForeignBlocks
= (and so on)

Each of these directories is for one module. For a module to be found and used by Mesquite, it
must be present in a directory whose name is the same as the class file for the module (e.g., the
class file for the module "Basic File Coordinator”, BasicFileCoordinator.class, must be in a
directory named BasicFileCoordinator).

Modules currently in use

While Mesquite is running you may want to learn what modules are currently running. In the Help
menu the Active Module Tree menu item displays a window that displays the modules currently
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running. You can also see the modules responsible for any window by touching on the Modules tab
in the window's information bar.

If you touch on the name of the module in theses module tree displays, a menu will drop down
that allows you to find out information about the module.

Information pages and Manuals for modules

Mesquite gathers information about each module and summarizes it in an information page for
each module. These are linked from the page available via the Modules Loaded menu item in the
Help menu while Mesquite is running. As well, some individual modules have their own manuals in
the form of web pages. These are also linked from the Modules Loaded web page.
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Mesquite's standard modules

The following is a list of the modules installed by default in this version of Mesquite, along
with the explanations of what they do.

ACGT Compositional Bias — Returns continuous characters which are the proportion
G+C, and separately A, C, G, T, for each taxon in a DNA data set.

e Add item... — Adds an item in each cell of a continuous matrix.
e Add Noise (Gaussian) — Adds normally distributed noise to existing states. Only the first

item of a continuous matrix is modified.

Add Noise to Branch Lengths — Adds noise to branch lengths of tree. Noise is Normally
distributed, with variance as selected. By default the variance is be proportional to
current branch length, so that if branch length is 10 and you've indicated a variance
multiplier of 0.1, the noise added will have a variance of 1.0. Negative branch lengths
are not allowed, and are changed to zero.

Add Note On Tree — Draws editable notes in a tree display.

Add Taxa To Tree — To a tree with some taxa excluded, adds taxa.

Add text to taxon names — Adds text to taxon names.

Add value — Alters continuous data by adding a value. All items of the matrix are
similarly modified.

Add/Delete Data — Adds and deletes characters and taxa in a Character Matrix editor.
This can be done through the Add characters..., Add taxa..., and Delete Selected
menu items and via the tools that add taxa and characters where touched.

Adjust lineage width — Provides a tool with which to adjust lineage widths a tree
window.

Aligment Score To Ref. — Reports the Aligment Score for a taxon in a data matrix. The
score for each taxon is the cost of aligning that taxon's sequence against the reference
taxon using Mesquite's default pairwise aligner. Lower scores mean a better alignment.
Align Package — Align is a Mesquite package providing tools for the alighment of
sequence data.

Align Score/RC Align Score To Ref. — Reports the Alignment Score / Reverse
Complement Alignment Score for a taxon in a data matrix. The score for each taxon is
the cost of aligning that taxon's sequence against the reference taxon using Mesquite's
default pairwise aligner, divided by the score for aligning the reverse complement of
the sequence against the reference. Scores greater than one mean that alignment is
better if one of the sequences is reverse complemented .

e Align Sequences — Sends the selected sequence to be aligned.
e Align To Dropped — Supplies an alignment tool that can be used on a set of sequences.

Sequences dropped by this tool on another sequence will be aligned to that other
sequence (pairwise).

All Branch Lengths to 1.0 — Assigns a value of 1.0 for branch length for all of a tree's
branches.

All Rerootings — Reroots tree at all nodes.

¢ All Unassigned Branch Lengths to 1.0 — Assigns a value of 1.0 for branch length for all

of a tree's branches that have not yet had a branch length assigned.

e Alter Branch Lengths — Alters branch lengths of selected trees.
e Alter Data — Manages data-transforming modules.
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Alter Trees — Alters selected trees.

Alternative Names — Lists the alternative names for the taxon.

Amino Acid Molecular Weight — Returns molecular weight of amino acid

Amino Acid Properties — Returns property of amino acid

Among-group PCA — Performs among-group principal components analysis on a

continous-valued matrix.

e Ancestral States All — Reconstructs ancestral states at nodes for all characters supplied
by character source.

e Ancestral States Reconstruction Package Introduction — Serves as an introduction to
the ancestral states reconstruction package for Mesquite.

e Annotate Branches — Supplies a tool for tree windows to attach and view footnotes for
branches.

e Annotation Panel module (list of characters) — Provides tools with which to attach
notes (including images) to characters and show them.

¢ Annotation Panel module (list of taaa) — Provides tools with which to attach notes
(including images) to characters and show them.

¢ Annotation Panel module — Provides tools with which to attach notes (including
images) to cells of the matrix and show them.

e Append numbers — Appends to each taxon name the number of the taxon. This will
ensure that each taxon name is unique.

e Arbitrarily Resolve State Ambiguities — Alters categorical data by arbitrarily resolving
ambiguous sites to one of the possible states.

e Assign All Branch Lengths — Assigns a value for branch length for all of a tree’s
branches.

e Assign Selected Branch Lengths — Assigns a value for branch length for all of a tree's
selected branches.

e Assign taxon names — Assigns to each taxon name a string followed by a number. For
example, if the string is "g", then taxon 3 will be assigned the name g3.

e Assigned Colors — Provides a tool with which to color cells of a matrix.

e Associated Taxa — Lists what other taxa (e.g. contained or containing) are associated
with these.

e Asymmetrical 2-param. Markov-k Model — Defines and maintains simple Markov k-state
asymmetrical 2-parameter stochastic models of character evolution.

e Asymmetry Likelihood Ratio Test — Calculates the test statistic for the likelihood ratio
test comparing the asymmetrical and one parameter models [2ln(L(Asymm.)/L(Mk1)],
on a tree for a given character.

e Attachment — Displays an item attached to trees.

e Augment Tree Randomly — Augments tree by random placement of excluded taxa.
There are three modes: adding only to original branches, ignoring lengths; adding to
any branch, considering branch length; adding to any branch, ignoring branch length.
With lengths considered, probability of placing taxon on a branch is proportional to the
branch’s length.

e Average of Several Distances — Average of several distances among taxa, e.g. average
from several data matrices.

e Average Taxon Value among Trees — Averages among trees a value calculated for a
taxon using a tree.

¢ Average Tree Value — Calculates the average of some value for trees in a tree block.

e Balls & Sticks — Draws trees with spots and the nodes and thin lines for branches.

e Bar & Line Chart — Helps make bar & line charts.



Module index 23.10.2007 4:28 PM

e Bar & Line Chart for Character Matrices — Shows chart displaying values (such as
treelength, etc.) for a series of character matrices.

e Bar & Line Chart for Characters — Shows chart displaying values (such as likelihoods,
parameter values, parsimony counts, etc.) for a series of characters.

e Bar & Line Chart for Taxa — Makes a chart displaying values (such as proportion of gaps
in a sequence, etc.) for each of a series of taxa.

e Bar & Line Chart for Trees — Makes a chart displaying values (such as likelihoods,
parsimony scores, imbalance statistics, correlations,etc.) for a series of trees.

e Basic Draw Names for Tree Display — Draws taxon names on a tree. Chooses orientation
of names according to orientation of tree.

¢ Basic File Coordinator — Coordinates the reading, maintenance and linkages of files,
which include Taxa, Trees, CharacterData, and other objects. This module is hired
directly by the Mesquite trunk module.

¢ Basic Tree Draw Coordinator — Coordinates the drawing of a tree by maintaining the
basic TreeDisplay and by hiring a DrawTree module.

e Batch Architect Package Introduction — Serves as an introduction to the Batch
Architect package for Mesquite.

e Batch File Template Manager — Manages templates used in saving batch files.

e Birth/Death Process Trees — Generates tree by simple birth/death model with a
constant rate of speciation (birth) and of extinction (death).

e BiSSE Ln Likelihood Difference — Calculates the difference in log likelihoods between
two BiSSE speciation/extinction models.

e BiSSE Net Diversification Likelihood (Calculator) — Calculates likelihood with a tree of
a species diversification model whose rates (r = spec. - ext.; a = spec./ext.) depend on
the state of a binary character (BiSSE model, Maddison, Midford & Otto, 2007).

e BiSSE Net Diversification Likelihood — Calculates likelihood with a tree of a species
diversification model whose rates (r = spec. - ext.; a = spec./ext.) depend on the state
of a binary character (BiSSE model, Maddison, Midford & Otto, 2007).

e BiSSE Speciation/Extinction Likelihood — Calculates likelihood with a tree of a species
diversification model whose speciation and extinction rates depend on the state of a
binary character (BiSSE model, Maddison, Midford & Otto, 2007).

e BiSSE Speciation/Extinction Likelihood Calculator — Calculates likelihood with a tree of
a species diversification model whose speciation and extinction rates depend on the
state of a binary character (BiSSE model, Maddison, Midford & Otto, 2007).

e BiSSE Trees & Characters — Generates tree by a speciation/extinction model in which
a character controls rates of speciation/extinction. Time to next event drawn from
negative exponential distribution.

e BLAST in Web Browser — BLASTSs selected data.

e Boolean for Tree (in List of Trees window) — Supplies booleans for trees for a trees list
window.

e Boolean Tree Value — Gives a tree a value of 1 if it satisfies the criterion, 0 otherwise.

e Bootstrap Resample Matrix — Resamples characters from a matrix for use in bootstrap
methods.

e Branch Information — Provides a tool that shows information about branches.

e Branch Length from Root — For each taxon, calculates the sum of the branch lengths
from that taxon to the root of the tree.

e Branch Lengths Adjust — Provides a tool to adjust branch lengths of trees.

e Brownian Model — Initializes Brownian motion character model for likelihood and other
probability calculations.
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e Calculated value for taxon — Supplies values for taxa reinterpreted as if characters.

e Canonical Variates Analysis — Performs canonical variates analysis on a continous-
valued matrix.

e Cell Wand (data) — Provides a tool with which to select cells in a matrix automatically.

e Character Compositional Bias — Calculates the percent of taxa with particular
nucleotides (GC bias, or individual frequency of A, C, G or T) for a character.

e Character Inclusion — Shows current character inclusion in character list window.

e Character Likelihood — Calculates the negative log likelihood of a tree for a given
character.

e Character List — Makes windows listing characters and information about them.

e Character Loadings — Returns loadings of a character in an ordination

e Character Matrices List — Makes windows listing character data matrices and
information about them.

e Character Matrices Package Introduction — Serves as an introduction to the basic
character matrices package for Mesquite.

e Character Matrix Editor — Makes editor windows to edit character data.

e Character Matrix manager — Coordinates the management of character data matrices.

e Character matrix selection coordinator — Coordinates selecting taxa and characters in

data matrix.

e Character Models List — Makes windows listing character models and information about
them.

e Character Reference Strip — Shows the strip at bottom of matrix with character
reference.

e Character selection coordinator — Coordinates character selection.

e Character Sort (data) — Provides a tool with which to sort characters automatically.

e Character Source — Coordinates the supply of characters from various sources of
characters.

e Character Source — Coordinates the supply of characters from various sources of
characters.

e Character value using other character — Coordinates the calculation of a number for a
character based on another character (e.g., a correlation between the two
characters).

e Character value with current tree — Coordinates the calculation of a number for a
character based on a current tree.

e Character value with respective tree — Coordinates the calculation of a number for a
character based on a respective tree.

e Character value with tree — Coordinates the calculation of a number for a character
based on a tree.

e Character Wand (data) — Provides a magic wand tool with which to select characters
automatically.

e Character-Associated Diversification — Coordinates analyses for the effect of a
character on diversification (speciation/extinction).

e Character/State Information — Exports character and state information for categorical
matrix.

e Characters from Matrix Source — Supplies characters from source of matrices.

e Characters from Ordinations — Supplies a character from an ordination of an existing
matrix.

e Characters Scattergram — Makes a scatterplot displaying two values (such as
likelihoods, parsimony scores, etc.) for a series of characters.
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e Chart from Instruction File — Displays a chart summarizing data contained in files, as
directed by an instruction file.

e Circular tree — Draws trees in circular form.

Clade Match with Another Current Tree — Calculates a number relating a clade and

another current tree (e.g., a tree-to-tree distance metric).

Clustal (DNA/RNA) — Imports Clustal files that consist of DNA or RNA sequence data.

Clustal (protein) — Imports Clustal files that consist of amino acid sequence data.

Clustal Align — Sends the selected sequence to Clustal to align.

Cluster analysis — Supplies trees obtained from cluster analysis on distance matrices.

Coalescence Contained within Current Tree — Generates tree by a simple coalescence

model of a neutral gene with constant population size, within a current species tree

from a Tree window or other tree context. Branch lengths are assigned according to
generation of coalescence.The species tree used is a current tree found in a Tree

Window or other tree context.

e Coalescence in Current Tree with Migration — Generates tree by a simple coalescence
model of a neutral gene with constant population size, within a current species tree
from a Tree window or other tree context. Branch lengths are assigned according to
generation of coalescence. The default population size is 10000. The species tree used
is a current tree found in a Tree Window or other tree context. Migration is allowed;
the default probability is 0.00001 per individual generation. Migration can be isolated
to a particular generation, or spread throughout the depth of the species/population
history.

e (Coalescence Package Introduction — Serves as an introduction to the coalescence
package.

e (Coalescence Simulated within Current Tree — Generates tree by a simple coalescence
model of a neutral gene with constant population size, within species trees. Branch
lengths are assigned according to generation of coalescence.The species tree used is a
current tree found in a Tree Window or other tree context.

e Coalescent Trees — Generates tree by coalescence within a single panmictic
population.

e Codon Position Rates Model — Defines and maintains models that specify rates for
codon positions.

e Collapse Gaps to Left — Collapses gaps in the selected block of cells to yield unaligned
sequences.

e Collapse Gaps to Right — Collapses gaps in the selected block of cells to the right, to
yield unaligned sequences.

e Collapse Zero-length Branches — Collapses zero-length branches to yield polytomes.

e Colless's Imbalance — Calculates Colless's Imbalance statistic for tree asymmetry,
normalized by maximum asymmetry. Polytmous nodes are ignored in the calculation.

e Color Branches — Provides a tool with which to color branches in a tree window.

e Color Branches by Partition — Colors the tree's branches by the taxon partition.

e Color By Amino Acid — Colors the cells of a DNA matrix by the amino acids for which
they code.

e Color By Cell Value — Colors the cells of a character matrix according to a value for
that cell or a moving window of cells.

e Color By Character Value — Colors the cells of a character matrix according to a value
for the character or a moving window of characters.

e Color By Footnote — Colors the cells of a character matrix by whether or not they have
a footnote.
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Color By State — Colors the cells of a character matrix by their contained character
states.

Color By Taxon Value — Colors the cells of a character matrix according to a value for
the Taxon or a moving window of taxa.

e Color For Aligning — Colors the cells of a character matrix for easy of alignment.
e Color If Excluded — Colors the excluded characters gray.
e Compare Bases with Taxon — Compares nucleotide bases of selected taxa with those of

a chosen taxon.

e Compare Other Matrix — Compares matrix in data editor with another.
e Compare with Another Current Tree — Calculates a humber relating a tree and another

current tree (e.g., a tree-to-tree distance metric).

Compare with Other Trees — Calculates a number relating one tree to another in a
sequence (e.g., a tree-to-tree distance metric), such that the i'th tree is compared to
the i'th other tree in the sequence.

Composite DNA Simulation Model — Defines and maintains simple stochastic models of
DNA evolution for simulations.

Concatenate Other Matrix — Concatenates matrix onto one in data editor. Assumptions
like weights and character models are NOT transferred. For categorical data, state
names are not included. For continuous data, new items may need to be created to
accommodate differences in items between the matrices.

e Concatenate tree blocks — Concatenates selected tree blocks into a new tree block.

Condense taxon names — Condenses taxon names, for example for use by programs
that cannot handle long names or names with punctuation.

Consensus Sequence Strip — Displays a consensus sequence as in info strip in a
character matrix editor.

Consensus State for Character —

Consensus trees — Supplies consensus trees.

Constellation — Draws trees with spots at the nodes in a more or less unrooted way.
Contained Associates — Draws wide trees containing trees of associates (e.g., species
tree containing gene tree)

e Continuous state of taxon — State of a continuous character.

Convert Negative Branch Lengths to Zero — Adjusts a tree's branch lengths so that
negative branch lengths are zero

Convert Polymorphisms to Uncertainties — Alters categorical data by converting
polymorphic entries to uncertainties.

Convert Uncertainties to Polymorphisms — Alters categorical data by converting
uncertain entries to polymorphisms.

e Correl Package — Correl is a Mesquite package for examining character correlation.
e Correlation Analysis — Performs a Correlation analysis for categorical characters.

Current Codon Positions — Supplies current codon positions applied to characters for
character list window.

Current Genetic Codes — Shows current genetic codes applied to characters in
character list window.

Current Genetic Codes — Supplies the currently assigned genetic code (e.g., "standard”)
for a character.

Current Parsimony Models — Shows current parsimony models applied to characters in
character list window.

Current Parsimony Models — Supplies the currently assigned parsimony model (e.g.,
"unordered”) for a character.
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Current Probability Models — Supplies current stochastic models applied to characters
for character list window.

Current probability models — Supplies the currently assigned stochastic (likelihood,
probability) model for a character.

e Current taxa partition — Supplies the current taxa partition.
e Current Tree — Supplies a single tree currently shown in a tree window.
e Current Weights — Supplies current weights applied to characters for character list

window.

e Curvogram — Draws trees with curved branches (as PHYLIP's ‘Curvogram’).
e Data Painter — Supplies the paint can tool and dropper tool for filling cells in a

character data editor.

Data type for model — Indicates data type of model in list window.

Data Window Coordinator — Coordinates the creation of basic data windows.
Deassign Branch Lengths — Sets lengths of a tree's branches to unassigned.

Deep Coalescences (gene tree) — Counts W. Maddison's (1997) number of extra gene
lineages ("deep coalescences”) for gene tree within species tree

Deep Coalescences (species tree) — Counts W. Maddison’'s (1997) number of extra gene
lineages ("deep coalescences”) for species tree implied by a contained gene tree
Deep Coalescences Multiple Loci — Counts W. Maddison's (1997) number of extra gene
lineages ("deep coalescences”) for species tree containing a series of gene trees. The
gene trees must be represented by a single taxa block.

Default Order (characters) — Shows default order of character.

Default Order (taxa) — Shows default order of taxa.

Default Trees — Supplies simple default trees (bush, ladder).

Defaults — Supervises some Mesquite-wide defaults

Definite Tree Source — Supplies trees from from a tree source, arranged to be a
definite number

Delete Reticulations — Deletes secondary parents of nodes with more than one
immediate ancestor. There is no control over which parents get deleted.

Dependent Contained Tree Window — Displays a single tree (the same as contained
within a tree in a tree window).

¢ Dependent Tree Window — Displays a single tree (the same as in a tree window).
e Diagonal tree — Draws trees with standard diagonal branches (“cladogram”)
e Difference in steps in two characters — Calculates the difference between two

characters in parsimony steps for a given tree.

Difference in two values for character — Coordinates the calculation of the difference
in two numbers for a character.

Display Character Loadings — Shows character loadings in ordination.

Display Mean — Calculates and shows the mean value.

Distance between taxa — Counts the difference between two taxa.

Distance of Contained Taxa — Distances among taxa according to distances among
contained taxa (e.g., genes).

Distances from Character Matrix — Distances calculated from a character matrix.

e Diverse Package — Diverse is a Mesquite package for examining speciation and

extinction.

Diversification (Char. Indep.) — Coordinates analyses of diversification
(speciation/extinction).

DNA Empirical State Frequencies Model — Defines and maintains model of state
frequences that match those found in an empirical matrix.
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DrawHierarchy — Draws project and module trees

E-mail Tree — Calls mailto: to email a text image of the tree.

Edit State Names — Edits state names of a categorical data matrix.

Equiprobable Trees — Generates trees randomly so that each possible labelled tree

topology is equally likely.

e Evolutionary Principal Components — Performs Maddison and Dyreson's evolutionary
principal components analysis on a continous-valued matrix.

e Evolve Categorical Characters — Simulates character evolution for categorical
characters on a tree.

e Evolve Continuous Characters — Simulates character evolution for continuous
characters on a tree.

e Evolve DNA Characters — Simulates evolution of DNA sequences on a tree.

e Evolving Speciation Rate (Continuous Character) — Generates tree by a speciation
model in which the speciation rate evolves by a Brownian motion model.

e Examples Navigator — Provides a Examples Navigator window with explanation and
buttons to link to other files

e Export Distance Matrix — Generates distance matrices in the manner of PDDIST
(Garland, T., Jr., and A. R. Ives. 2000)

e Export Matrices & Batch Files — Saves copies of matrices to separate files for

subsequent batch analysis (e.g., parametric bootstrapping).

Export NEXUS for MrBayes — Exports NEXUS files for use by MrBayes.

Extract tree block — Extracts selected trees and places them in a new tree block.

F81 distance — F81 (Felsenstein, 1981) distance from a character matrix.

F84 distance — F84 (Felsenstein, 1984) distance from a DNA matrix.

FASTA (DNA/RNA) — Imports and exports FASTA files that consist of DNA/RNA sequence

data.

e FASTA (protein) — Imports and exports FASTA files that consist of amino acid sequence
data.

e Fetch & Add GenBank Sequences — Fetches GenBank nucleotide sequences given their

GenBank accession numbers and adds them to the matrix.

File Comment — Manages the main file comment in a NEXUS file.

Fill — Fills cells with a uniform state in a character data editor.

Filter Trees from Other Source — Filters trees from another source.

Find Sequence — Finds the next occurrence of a sequence in a matrix of molecular

data.

e Forward/Backward Rates — Uses maximum likelihood to estmate the rates of forward
and backward changes (0 to 1 and 1 to 0 changes respectively), or alternatively the
overall rate and the bias in gains versus losses, using the AsymmMk model on a tree for
a given character.

e Frequency of State — Calculates the frequency of a state for a categorical character

e Fused Matrix Export (NEXUS) — Exports NEXUS files with matrices fused.

e Gamma Invar Rates Model — Defines and maintains Gamma rate variation models with

a proportion of invariant characters.

Gamma Rates Model — Defines and maintains Gamma rate variation models.

Gaps to Missing — Converts gaps to missing data in selected region.

GC — Returns 1 forGor C, O forAorT.

Gene Duplication-Extinction (gene tree) — Counts the number of duplication and

extinction events for gene tree implied by a containing species tree

e Gene Duplication-Extinction (species tree) — Counts the number of duplication and
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extinction events for species tree implied by a contained gene tree

¢ Genesis Introduction — Serves as an introduction to the Genesis package, which
implements models of character evolution.

e Go-to Window — Provides a window to jump to another file

e Group Membership (characters) — Lists and allows changes to group membership in the
current partition of characters, for List of Characters window.

e Group Membership (taxa) — Lists and allows changes to group membership in the
current partition of taxa, for List of Taxa window.

e GTR Rate Matrix Model — Defines and maintains six-parameter general time-reversible
(GTR) rate matrix models.

e Heuristic (Add & rearrange) — Searches for optimal trees by adding taxa then
rearranging the tree.

e Highlight Apparently Slightly Misaligned — Colors aligned sequences to emphasize
sections that seem slightly misaligned.

e |Import and Export Package Introduction — Serves as an introduction to the
import/export package for Mesquite.

¢ Include Taxa from File — Includes a file and concatenates its taxa to an existing taxa

block, for instance to add segences.

Initialize DNA Submodels — Initializes default DNA submodels.

Initialize Genetic Code — Initializes default genetic codes.

Initialize Parsimony — Initializes default character models for parsimony.

Initialize predefined categorical parsimony models — Initializes the predefined

categorical parsimony models.

¢ |nitialize predefined continuous parsimony models — Initializes the predefined
continuous parsimony models.

¢ Insert Node — Provides a tool with which to insert nodes along a branch.

¢ |nterpolate Character Selection — Selects characters that are surrounded by characters

selected.

Item values chart — Manages chart of values for items.

Iltems bi-plot — Makes a chart comparing two values for each of many items.

iText — iText is a package for save PDF files within Mesquite.

JAMA Introduction — Serves as an introduction to the JAMA library used in Mesquite.

Jukes Cantor distance — Jukes Cantor distance from a character matrix.

K2P distance — K2P (Kimura 2-parameter) distance from a character matrix.

Kyte & Doolittle Hydrophobicity — Returns hydrophobicity of amino acid using the scale

of Kyte, J & R.F. Doolittle (1982) J. Mol. Biol. 157:105-142. Numbers from

http://www.whatislife.com/reader/protein/aa.html

e Label Branch Lengths — An assistant to a tree display that labels branches to show
their lengths.

e Label states — A module that displays character states on tree using labels. This is a
display-only module, and would be hired by another module that organizes assigning
states to the nodes.

e Landmark Drawings — Places drawing of landmarks at each node in tree.

e Likelihood Ancestral States — Coordinates reconstruction of ancestral states by
maximum likelihood. Currently each node is estimated independently (i.e.,
corresponding to PAUP's marginal reconstruction).

e Likelihood in Character — Calculates the negative log likelihood of a tree with respect
to a single character.

e Likelihood Surface AsymmMk Model — Shows the likelihood surface for the AsymmMk
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Model.

Lineages Through Time — Displays a window showing plot of lineages through time
averaged over many trees.

List of Character Inclusion Sets — Makes windows listing character sets.

List of Character Partitions — Makes windows listing character partitions.

List of Character Sets — Makes windows listing character sets.

List of Character Weight Sets — Makes windows listing character weight sets.

List of Codon Positions Sets — Makes windows listing codon positions sets.

List of Genetic Code Sets — Makes windows listing genetic code sets.

List of Parsimony Model Sets — Makes a window listing parsimony model sets.

List of Probability Model Sets — Makes windows listing probability model sets.

List of Taxa Partitions — Makes windows listing taxa partitions.

List of Taxon Sets — Makes windows listing taxon sets.

Log transform — Alters continuous data by log transforming values.

Lower Case — Returns 1 if state symbol is a lower case letter.

Maintain Clipboard Match — Finds the first occurrence of the sequence in the
clipboard, within a designated taxon, and maintains that match as the clipboard
changes.

Maintain Target Match — Finds the first occurrence of the sequence in the text area
below the matrix, within a designated taxon, and maintains that match as the text
area changes.

Make Rerootings of Clade — Presents a tool by which you can touch on a tree; a tree
block is made consisting of trees representing all rerootings of the clade of the node
touched.

Manage alternative taxon names — Manages (including NEXUS read/write) alternative
taxon names.

e Manage ASSUMPTIONS blocks — Manages ASSUMPTIONS block in NEXUS file.
e Manage Attached Notes — Manages (including NEXUS read/write) notes attached to

taxa, characters and cells of matrices.

e Manage AUTHORS blocks — Manages AUTHORS block in NEXUS file.

Manage categorical character matrices — Manages categorical data matrices (including
read/write in NEXUS file).

Manage character inclusion sets — Manages (including NEXUS read/write) character
inclusion sets (EXSETS).

¢ Manage Character Models — Manages character models.
e Manage character partititions — Manages (including NEXUS read/write) character

partitions.

Manage character sets — Manages (including NEXUS read/write) character sets
(CHARSETS).

Manage character weight sets — Manages (including NEXUS read/write) character
weight sets.

Manage codon positions — Manages (including NEXUS read/write) codon position sets.

e Manage CODONS blocks — Manages CODONS block in NEXUS file.
¢ Manage Continuous char. matrices — Manages continuous data matrices (including

read/write in NEXUS file).
Manage DNA/RNA matrices — Manages DNA/RNA data matrices (including read/write in
NEXUS file).

e Manage Foreign Blocks — Manages unrecognized blocks in a NEXUS file.

Manage genetic code sets — Manages (including NEXUS read/write) genetic code sets
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(CODESETS).

¢ Manage Geographic character matrices — Manages data matrices of geographic data
(including read/write in NEXUS file).

¢ Manage hyperlinks — Manages (including NEXUS read/write) hyperlinks.

e Manage LABELS blocks — Manages LABELS block in NEXUS file.

e Manage MESQUITE block — Manages MESQUITE block (including compose snapshot of
current state of file in MESQUITE block "Auto” in NEXUS file).

¢ Manage MESQUITECHARMODELS blocks — Manages MESQUITECHARMODELS block in
NEXUS file.

e Manage NOTES blocks — Manages footnotes and pictures attached to taxa, characters
and data points (including read/write NOTES block in NEXUS file).

e Manage parsimony model sets — Manages (including NEXUS read/write) parsimony
model sets (TYPESETS).

e Manage pictures — Manages (including NEXUS read/write) pictures.

e Manage probability model sets — Manages (including NEXUS read/write) probability
model sets (PROBMODELSETS).

¢ Manage Protein matrices — Manages Protein data matrices (including read/write in
NEXUS file).

e Manage SETS blocks — Manages character sets and other sets of various kinds (including
read/write SETS block in NEXUS file).

e Manage stored character orders — Manages (including NEXUS read/write) character
orders.

e Manage TAXA blocks — Manages sets of taxa (including read/write TAXA block in NEXUS

file).

Manage taxa partititions — Manages (including NEXUS read/write) taxa partitions.

Manage TaxaAssociation blocks — Manages TaxaAssociation blocks in NEXUS file.

Manage taxon sets — Manages (including NEXUS read/write) taxon sets.

Manage TREES blocks — Manages tree blocks (including read/write TREES block in

NEXUS file).

e Map Continuous — Supplies a reconstruction of continuous-valued ancestral states on a
tree. Differs from the basic reconstruction methods in that it supplies simply humbers
for nodes, instead of a CharacterHistory

e Matching Sequence — Finds the next occurrence of a sequence in a matrix of molecular
data. Allows a certain number of mismatches.

e Matrices from Ordinations — Supplies character matrices from ordinations of existing
matrices.

e Matrix from Clipboard — Makes a character matrix from text in the clipboard.

e Matrix Info — Shows Information about the data in each taxon.

e Matrix Source (indep.) — Coordinates the supply of matrices to other modules. It acts
independently, in that it decides what matrix to supply (e.g., by presenting an
interface to choose).

e Matrix Source (obed.) — Coordinates the supply of matrices to other modules. It acts
obediently, in that it does not present an interface to choose which matrix, but relies
on employer to decide.

e Matrix value with current tree — Coordinates the calculation of a number for a
character matrix based on a current tree.

¢ Maximum likelihood reconstruct (Generic categorical) — Assesses likelihood for
categorical characters, and r econstructs ancestral states by the maximum marginal
probability ("MLE") criterion
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e Mean value of character (linked matrix) — Calculates the mean observed trait for
continuous character in a linked matrix.

¢ Mean value of character — Calculates the mean observed trait for continuous
character.

e Merge Taxa — Merges selected taxa and their character states.

e Mesquite — This is the central module for the Mesquite system. In it is the main
method that starts up the Mesquite application. This moduleloads information for all of
the other modules, and hires FileCoordinator modules as needed to deal with open
files. Thus, in the tree of employeesthat active modules make, this module is at its
root.

e Mesquite — This is the central module for the Mesquite system. In it is the main
method that starts up the Mesquite application. This moduleloads information for all of
the other modules, and hires FileCoordinator modules as needed to deal with open
files. Thus, in the tree of employeesthat active modules make, this module is at its
root.

e mesquite.jsci Package Introduction — Serves as an introduction to the portions of JSci
used by Mesquite.

e Mirror Tree Window — Displays a single tree (the same as in a tree window) twice, in
mirror image.

¢ Missing to Gaps — Converts missing data to gaps in selected region.

e Mk1 Estimated Rate — Estimates the rate of a character's evolution under the simple
Mk1 model.

e Mk1 Model (Markov 1 parameter) — Defines and maintains simple Markov k-state 1-
parameter stochastic models (Lewis, 2001) of character evolution.

¢ Model Paradigm — Indicates paradigm of model in list window.

¢ Modify Current Tree — Modifies current tree.

e Most Pairs — Chooses taxon pairings regardless of contrast in a character, so as to
maximize the number of pairs that are phylogenetically independent.

¢ Move block — Allows one to manually blocks in a sequence, and split the blocks.

e MrBayes Max. A-Post. Tree — Supplies tree from MrBayes with highest posterior
probability (MAP tree).

e MrBayes Score — Supplies posterior probability score from MrBayes

e MrBayes Trees — Supplies trees from MrBayes

e MRP Matrices from Trees — Supplies matrices which represent trees for MRP (Matrix
Representation with Parsimony) supertree analyses.

e Multi Tree Window — Displays a special tree window with many trees simultaneously.

e Multiply by value — Alters continuous data by multiplying by a value. All items of the
matrix are similarly modified.

e Multistate sites in taxon — Reports the number of polymorphic/partially uncertain sites
in a taxon for a data matrix.

e NBRF/PIR (DNA/RNA) — Imports and exports NBRF files that consist of DNA/RNA
sequence data.

e NBRF/PIR (protein) — Imports and exports NBRF files that consist of amino acid
sequence data.

e Neutral Coalescence — Performs neutral coalescence within a population by a simple
model of a neutral gene with constant population size.Remembers a tree of nodes,
with branch lengths assigned according to generation of coalescence. The default
population size is 10000.

e NEXUS Blocks List — Makes windows listing NEXUS blocks.
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NEXUS Defaults — Sets whether TITLE and LINK commands are to be suppressed where
possible in saving NEXUS files.

e NEXUS file interpreter — Coordinates the reading and writing of NEXUS files.

NNI Rearranger — Rearranges a tree by nearest neighbor interchange (NNI). Does not
handle trees with polytomies.
No Color — Turns off cell coloring.

¢ Node Count (Speciation Patristic) Distances implied by Tree — Distances among taxa

implied by counting nodes along branches of tree from one taxon to another
(Speciation Patristic distances).

e Node Depth — Calculates the depth of each node from the highest terminal in its clade.
¢ Node Locations (2D plot) — Calculates the node locations for a tree plotted in a two

dimensional space.

Node Locations (3D plot) — Calculates the node locations for a tree plotted in a three
dimensional space.

Node Locations (circle) — Calculates the node locations for a tree drawn in circular
fashion, with root at center.

Node Locations (oval) — Calculates the node locations for a tree drawn in oval fashion,
with root at center.

Node Locations (standard) — Calculates the node locations in a tree drawing, for use
with vertical or horizontal tree drawers (e.g., the standard diagnonal or square trees).
Node Namer — Provides a tool to name the nodes of a tree

Node Position Adjust — Provides a tool to adjust the depth of a node in the tree

Nodes Scattergram — Shows values for nodes of tree via a scattergram.

Nucleotide Complement — Alters nucleotide data to its complement.

Number for Character (in List of Characters window) — Supplies humbers for characters
for a character list window.

Number for Matrix (in List of Character Matrices window) — Supplies numbers for
character matrcies for a character matrices list window.

Number for Nodes using Character — Supplies humbers, based on a character, for each
node of a tree.

Number for Nodes using Matrix — Supplies humbers, based on a matrix, for each node
of a tree.

Number for Taxon (in List of Taxa window) — Supplies numbers for taxa for a taxa list
window.

Number for Tree (in List of Trees window) — Supplies numbers for trees for a trees list
window.

Number for Tree Block (in List of Tree Blocks window) — Supplies numbers for tree
blocks for a tree blocks list window.

Number of characters in character set — Indicates number of characters in character
set in list window.

Number of characters in inclusion set — Indicates number of characters in inclusion set
in list window.

Number of characters of data matrix — Indicates taxa of data matrix.

e Number of groups in taxa partition — Indicates number of groups in taxa partition in

list window.
Number of Stops — Reports the number of stops coded by nucleotides in a taxon for a
data matrix.

e Number of Taxa — Counts the number of taxa in a tree.

Number of taxa in set — Indicates number of taxa in list window.
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Number of taxa in taxa set — Indicates number of taxa in taxa set in list window.
Number of trees in tree block — Indicates number of trees.

Number of Unambiguous Sites in Sequence — Reports the number of unambiguous sites.
Number of Taxa with Non-Gap, Non-Missing — Calculates the number of taxa in the
character that contain applicable, non-missing data.

Numbers for Nodes from Character Reconstructions — Supplies numbers, based on a
character reconstruction, for each node of a tree.

Occasionally Randomly Modify — With specified probabililty, will ask random tree
modifier to modify current tree.

e Open URL — Opens a file on the web as if it were a local data file
e Original File (import source) — Shows the orignal file from which a fuse/imported taxon

came.

e Other Tree Blocks — Supplies blocks of trees from various sources

Pagel format (ppy) file for Discrete — Imports and exports files formatted for Pagel's
Discrete program.

Pagel format (ppy) file for Multistate — Imports and exports files formatted for Pagel's
Multistate program.

Pagel's 1994 test of correlated (discrete) character evolution — A statistical test,
described in Pagel(1994), for nonindependent evolution of two discrete, binary
characters

Pairs for one character — Chooses taxon pairings so as to maximize the number of pairs
that are phylogenetically independent, subject to the constraint that each pair shows a
contrast the states of a binary character.

Pairs for two characters — Chooses taxon pairings so as to maximize the number of
pairs that are phylogenetically independent, subject to the constraint that each pair
shows a contrast the states of both of two binary characters.

Pairwise Comparison — Performs pairwise comparison character correlation tests.
Phylogenetically independent pairs are chosen, and the states of two binary characters
are compared to see if they are correlated among these pairs.

Pairwise Comparisons Package Introduction — Serves as an introduction to the pairwise
comparisons character correlation package for Mesquite.

e PAL Introduction — Serves as an introduction to the use of the PAL library in Mesquite.
e Parameters Explorer — Provides a window to show values returned when parameter

settings are varied
Parsimony Ancestral States — Coordinates the parsimony reconstruction of ancestral
states.

e Parsimony Character Steps — Calculates the number of parsimony steps in a character.
e Parsimony Linear — Reconstructs the ancestral states of continuous characters so as to

minimize the sum of absolute values of changes (linear, Wagner, Farris or Manhattan
parsimony). If the continuous character has multiple items, then length is reported on
only the first item.

Parsimony Ordered — Reconstructs the ancestral states of categorical characters using
parsimony, under the assumption that states are ordered (ordered, Farris or Wagner
parsimony; additive). Also counts parsimony steps.

Parsimony Package Introduction — Serves as an introduction to the basic parsimony
package for Mesquite.

Parsimony Squared-change — Reconstructs the ancestral states of continuous characters
so0 as to minimize the sum of squared changes (squared-change or least squares
parsimony; Brownian motion likelihood).
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Parsimony Stepmatrix — Reconstructs ancestral states of categorical characters using a
stepmatrix (cost matrix).

Parsimony Unordered — Reconstructs the ancestral states of categorical characters
using parsimony, under the assumption that states are unordered (unordered or Fitch
parsimony; nonadditive). Also counts parsimony steps.

Patristic distance correlation — Calculates the product moment correlation coefficient
among the off-diagonal elements of the patristic distances matrices of two trees.
Ignores unassigned and negative values in the matrices. If employed as a distance,
converts scores from 1 to -1 to scores from 0 to 2

Patristic Distances implied by Tree — Distances among taxa implied by path-length
distance along branches of tree from one taxon to another (Patristic distances).
Unassigned branches are treated as of length 1.0.

Phylip (categorical data) — Imports and exports Phylip matrices that consist of basic
categorical data with just two states. Exported data will consist of default symbols (0
and 1).

Phylip (DNA/RNA) — Imports and exports Phylip matrices that consist of DNA/RNA
sequence data.

Phylip (protein) — Imports and exports Phylip matrices that consist of amino acid
sequence data.

Phylip (trees) — Imports and exports Phylip trees.

Picture Window — Displays a picture in a window.

Plot Tree — Draws trees plotted in a two dimensional space.

Plot Tree 3D — Draws trees plotted in a three dimensional space.

Polytomies Present — Indicates whether polytomies are present.

Polytomy Assumption — Indicates whether the tree assumes that any polytomies, if
present, are hard or soft. If not, the default assumption is used.

e POY (DNA/RNA) — Exports POY files of DNA/RNA sequence data.
e Principal Components Analysis — Performs principal components analysis on a

continous-valued matrix.

Projector — Supplies a projector tool for tree windows that allows pictures attached to
taxa to be displayed.

Proportion Gaps In Character — Calculates the proportion of gaps (inapplicable codings)
in a character across taxa. Does not include missing (unassigned) data.

Proportion Gaps in Taxon — Reports the proportion of gaps (inapplicable codings) in a
taxon for a data matrix.

Proportion Internal Gaps — Calculates the proportion of internal gaps (inapplicable
codings) in a character across taxa. Does not include missing (unassigned) data.
Proportion Invariant Model — Defines and maintains models that specify that a certain
proportion of characters are invariant.

Proportion lower case codings in taxon — Reports the percentage of lower case codings
in a taxon for a data matrix.

Proportion Missing — Calculates the proportion of missing data in a character across
taxa.

Proportion missing data in taxon — Reports the proportion of missing data in a taxon
for a data matrix.

Proportion Polymorphic — Calculates the proportion of taxa coded as polymorphic or
partially uncertain in a character.

Proportion Terminal Gaps — Calculates the proportion of Terminal gaps (inapplicable
codings) in a character across taxa. Does not include missing (unassigned) data.
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e Protein Site Property — Calculates the mean value of amino acid properties at a site
across taxa.

e Quick Key Entry — Provides a tool with which to quickly enter data. If this tool is
active, then typing a key will cause that value to be entered into all selected cells.

e Random Branch Moves — Rearranges tree by random branch moves.

e Random Fill (Categorical) — Fills cells with a randomly-chosen state. For DNA data,
states A, C, G, and T are chosen with equal probability; for other data, states up to
and including the maximum state value are chosen with equal probability.

e Random Fill (Gaussian/Normal) — Fills cells with a random state, using a Normal

distribution.

Random Fill (Uniform) — Fills cells with a random state, uniformly.

Random n characters — Selects n characters randomly.

Randomly Modify Current Tree — Modifies current tree by random changes.

Randomly Modify Matrix — Supplies character matrices that are randomly modified from

an existing matrix.

e Randomly Modify Respective Matrices — Supplies character matrices that are randomly
modified from a series of existing matrices. The i'th modified matrix is derived from
the i'th original matrix.

e Randomly Modify Trees — Modifies each of a series of trees by random changes; the i'th
tree from this module comes by modifying the i'th tree from the original source of
trees.

e Randomly Resolve Polytomies — Randomly resolves polytomies in tree. All possible
resolutions are equiprobable. Thus, if the tree is a polytomous bush, the resulting
resolved trees will be distributed equivalently to that from the Equiprobable Trees
module.

e Rarefy Characters — Deletes characters randomly to rarefy matrix.

e Rarefy Tree — Rarefies tree by randomly excluding taxa. If some taxa are selected,
random exclusion is limited to the selected taxa.

e Raw Nexus block editor — Edits blocks in a NEXUS file.

e Read DATA blocks — Coordinates the reading of a DATA block in NEXUS file.

e Read DISTRIBUTION blocks — Coordinates the reading of a DISTRIBUTION block in NEXUS
file.

e Rearranged tree — Supplies trees that are rearrangments of a given tree. The original
tree is NOT included among the rearrangements.

e Recode Characters — Recodes categorical data (e.g., state 1 to state 0).

e Reconstruct Ancestral States — Reconstructs ancestral states on the nodes of a tree.

e Reconstruct Deep Coalescence — Reconstructs a contained tree within a containing
tree so as to minimize the amount of deep coalescence (failure of lineage sorting). The
contained tree is assumed to be rooted.

e Remove from Taxon Names — Removes a specified number of characters from taxon

names.

Remove Gaps-Only Characters — Removes all characters that are gaps only.
Remove item... — Removes an item in each cell of a continuous matrix.
Rename item... — Renames an item of a continuous matrix.

Replaces text in taxon names — Replaces text in taxon names.

Reshuffle Character — Supplies characters that are reshufflings of an existing
character.

e Reshuffle States Within Characters — Shuffles (permutes) character states among taxa
within each character.



Module index 23.10.2007 4:28 PM

e Reshuffle States Within Taxa — Shuffles (permutes) character states among characters
within each taxon.

e Reshuffle Terminal Taxa — Shuffles (permutes) the taxa among the terminal nodes.

e Reshuffle Within Characters (Taxa Partitioned) — Shuffles (permutes) character states
among taxa of each taxa partition, within each character.

e Reshuffle Within Taxa (Char. Partitioned) — Shuffles (permutes) character states
among characters of each character partition, within each taxon.

e Resolve Polytomies (to 0-length branches) — Resolves polytomies arbitrarily and
assigned the resulting new branches zero length.

e Reverse Complement — Reverses the DNA sequence and complements the bases.

e Reverse Sequence — Alters data by reversing sequence of states.

e Rhetenor Package Introduction — Serves as an introduction to the Rhetenor
morphometrics package.

e Right-Ladderize Tree — Sets the tree to its ladderized (right) version.

e Root tree — Sets the tree to rooted.

e Root tree with selected taxa as outgroup — Roots the tree between the selected taxa
and the remainder, if possible.

e Rooting status — Indicates whether the tree is rooted or unrooted.

e s of Slatkin & Maddison — Calculates ‘s’ of Slaktin & Maddison 1989 for tree of genes
associated with given populations

e Sample Trees Directly From File — Supplies randomly-sampled trees directly from a
file, without bringing the contained tree block entirely into memory. This allows much
larger blocks of trees to be used within constraints of memory, but will make some
calculations slower. This module does not know how many trees are in the file, and
hence may attempt to read files beyond the number in the file.

e Save matrix copies — Provides for the saving of copies of matrices to separate files.
This is available under the Characters menu.

e Scale All Branch Lengths — Adjusts a tree's branch lengths by multiplying them by an
amount.

e Scale Selected Branch Lengths — Adjusts lengths of a tree's selected branches by
multiplying them by an amount.

e Scattergram — Helps make scattergram charts.

e Search Data — Manages data-searching modules.

e Select Branches — Provides a tool and menu with which to select branches in a tree
window.

e Select by Matrix Comparison — Selects cells of the matrix that differ compared to
another matrix

e Select By Search (Find all) — Selects cells of the matrix according to whether their text
contains a given string

e Select Lowercase Ends — Selects ends of a DNA sequence up to the first block of N
sites in a row with uppercase (confident) symbols (the user chooses N). Assuming that
lowercase letters are used for less certain base calls, this can be used to select and
then trim (by painting with gaps) poorly-sequenced terminal regions.

e Select Matching Taxa — Selects taxa according to whether their sequence of states
matches the sequence of states in the selected taxon

e Select Same Distribution — Selects cells of the matrix according to whether their
distribution of states across taxa in a character is the same as that in the selected
character or block of cells

e Select Same Subsequence — Selects cells of the matrix according to whether their
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sequence of states matches the sequence of states in the selected taxon or block of
cells

e Select Taxa — Provides a tool with which to select taxa in a clade in a tree window.

e Selected Taxa Convex in Tree — Determines if the selected taxa are convex in a tree.
That is, does there exist a rooting of the tree in which the selected taxa form a clade?

e Selected Taxa Form Clade — Determines if the selected taxa form a clade in a tree.

e Sequence Length — Reports the length (total minus gaps) of a molecular sequence in a
taxon.

e Set Author — Sets the author for this machine and account.

e Set Branch Lengths to Numbers For Nodes — Assigns a value of branch length for all of
a tree's branches based upon the numbers calculated by a Numbers for Nodes.

e Set Polytomy Assumption to Default — Sets assumption that any polytomies in the tree
are whatever is current default (which can be set by going to project and files or Log
window and choosing "Defaults>Set Polytomy Default...".

e Set Polytomy Assumption to Hard — Sets assumption that any polytomies in the tree
are hard.

e Set Polytomy Assumption to Soft — Sets assumption that any polytomies in the tree are
soft.

e Set to Lower Case — Alters nucleotide data to lower case coding (e.g, to indicate less
certain).

e Set to Upper Case — Alters nucleotide data to upper case coding (e.g, to indicate more
certain).

e Set Tree Defaults — Sets the default state for polytomies & other aspects of tree
handling.

e Shade numbers — A module that displays numbers at tree nodes using labels. This is a
display-only module, and would be hired by another module that organizes assigning
numbers to the nodes.

e Shade states — Shows the states at nodes by shading branches or nodes using colors,
black and white, or shades of gray.

e Shared Clades — Calculates the number of shared clades between two trees (excludes
the clade consisting of all taxa).

e Shared History Distances implied by Tree — Distances among taxa implied by length of
shared history (distance from root to most recent ancestor). Unassigned branches are
treated as of length 1.0.

e Shared Partitions — Calculates the number of shared partitions between two trees. If
used as a distance, then converted by subtracting shared partitions from the maximum
possible, i.e. the number of partitions in the subtree of shared taxa in the tree with
the most partitions.

e Shared Proportion Distances implied by Tree — Distances among taxa implied by
proportion of total branchlength (root to tip) that is shared (Shared Proportion
distances). Unassigned branches are treated as of length 1.0.

e Shift Other To Match — Shifts other sequences to match the one selected.

e Show Employee Tree — Shows the window listing the tree of employees of the module
of a given window.

e Show List with Genetic Codes — Shows the List of Character window with the genetic
codes column on.

¢ Show Node Numbers — Shows the node numbers on a tree.

e Show Percentile — Calculates and shows percentile boundaries. Finds the upper (right)
or lower (left) tail of the distribution that contains the specified percentage of the
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distribution. If there is not a boundary that exactly matches the specified percentage,
then the closest boundary that does not exceed the percentage is shown.

e Show text — Shows text in a window
e Show Y = X — Shows the Y=X line on a scattergram

Shuffle states among taxa — Alters data by shuffling states among taxa within a
character.
Side Pusher — Pushes all sequences on one side.

e Simple (categorical data) — Imports and exports simple matrices that consist of basic

categorical data. Exported data will consist of default symbols (0, 1, 2, ...).

Simple (DNA/RNA) — Imports and exports simple matrices that consist of DNA/RNA
sequence data.

Simple (protein) — Imports and exports simple matrices that consist of amino acid
sequence data.

Simplified NEXUS — Exports NEXUS files, for instance of old fashioned style (using DATA
block).

Simulate Ancestral States — Simulates ancestral states on the nodes of a tree.

e Simulated Characters — Supplies simulated characters.
e Simulated Characters on Trees — Supplies simulated characters each from a respective

tree.

e Simulated Matrices on Current Tree — Supplies simulated character matrices.
e Simulated Matrices on Trees — Supplies simulated character matrices, each evolved on

a different of a series of trees.

Simulated Tree Blocks — Creates a tree block of simulated trees.

Simulated Trees — Supplies trees from simulations.

Single Linkage — Supplies trees obtained from Single Linkage clustering.

Sister Diversification — Compares sister clades and returns the P value of the one-
tailed null hypothesis that uniform clades of state 1 are smaller than uniform clades of
state 0 among those with different values (P value calculated by Binomial probability).

e Sort Taxa (data) — Provides a tool with which to sort taxa automatically.
e Speciation/Extinction Likelihood — Calculates likelihoods using a speciation/extinction

model reduced from the BiSSE model (Maddison, Midford & Otto 2007)
Speciation/extinction Likelihood Calculator — Calculates likelihoods using a

speciation/extinction model reduced from the BiSSE model (Maddison, Midford & Otto
2007)

e SPR Rearranger — Rearranges a tree by subtree pruning and regrafting (SPR).
e Sprinkle Missing — Randomly converts entries in the character matrix to missing data,

with a certain probability (i.e., it "sprinkles” missing data around the matrix).

e Square tree — Draws trees with standard square branches ("phenogram®”)
e Standardize — Alters continuous data by standardizing to have mean = 0 and unbiased

estimate of variance = 1. Modifies only the first item of a multi-item matrix

e State Names Strip — Shows the strip at bottom of matrix with state names.
e States Information (in List of Characters window) — Supplies basic character state

information for characters in character list window.

e Stepmatrix — Supplies editor for and manages stepmatrices (cost matrices).
e Steps in Character — Calculates the parsimony steps in a character for a given tree.
e Stochastic Character Evolution Package Introduction — Serves as an introduction to the

basic stochastic character evolution package for Mesquite.
Stochastic Character Mapping (Categorical) — Coordinates reconstruction of ancestral
states using stochastic character mapping.
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Stored Character Order — Supplies current order applied to characters for character list
window.

Stored Characters — Supplies characters from data files (as opposed to simulated
characters, for example).

e Stored Genetic Code — Supplies a user-specified genetic code, stored in the file.
e Stored Matrices — Supplies character matrices from data files (as opposed to simulated

characters, for example).

Stored Parsimony Model — Supplies a user-specified model of character evolution, for
parsimony calculations, stored in the file. This can be different from the model
assigned to the character as current in the List of Characters window.

Stored Probability Model — Supplies a user-specified model of character evolution
stored in the file.

Stored Probability Model for Simulation — Supplies a user-specified model of character
evolution stored in the file for simulation.

Stored Taxa — Supplies taxa stored, for instance in a file.

Stored Taxa Associations — Supplies associations between taxa that are stored, for
instance in a file.

Stored Taxon Pairs — Supplies taxon pairs stored, for instance in a file.

Stored Tree Blocks — Supplies lists of trees stored, for instance in a file.

Stored Trees — Supplies trees stored, for instance in a file.

Sum of Branch Lengths — Calculates the sum of branch lengths of the tree, treating
unassigned lengths as 0. The length of the root is counted.

Tab-delimited categorical data file — Imports simple tab-delimited files of categorical
data.

Tab-delimited continuous data file — Imports and exports simple tab-delimited files of
continuous data.

Taxa Association Package Introduction — Serves as an introduction to the taxa
association package for Mesquite.

Taxa blocks list — Makes windows listing blocks of Taxa and information about them.
Taxa of data matrix — Indicates taxa of data matrix.

Taxa of tree block — Indicates taxa of tree block.

Taxa partition from Taxa associations — Constructs a taxa partition from an
association.

Taxa Scattergram — Makes a scatterplot displaying two values (such as proportion of
gaps in a sequence, etc.) for a series of taxa.

Taxon Instability Among Trees — Calculates for each taxon the degree to which its
implied unweighted patristic distances between that taxon and others differs among
trees. For each taxon i this sums over all tree pairs x and y and over all other taxa j: |
Dijx - Dijy |/(Dijx + Dijy)""z where Dijq is the distance between taxa i and j on tree
q. Close relationships are emphasized if the exponent z is higher (default is 2).

e Taxon Link — Supplies a tool for tree windows that jumps to hypertext links for taxa.
e Taxon List — Makes windows listing taxa and information about them.
e Taxon Pairs Histogram — Makes a chart showing some value for each of many pairs of

taxa.
Taxon Pairs Scattergram — Makes a chart comparing two values for each of many pairs
of taxa.

e Taxon selection coordinator — Coordinates taxon selection.
e Taxon Wand (data) — Provides a tool with which to select taxa automatically.

Terminal ? to Gaps — Converts terminal missing data codings to gaps.
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e Terminal Gaps to ? — Converts terminal gaps to missing data.
e Text Window — Displays Text in a window.
e Ti/Tv Rate Matrix Model — Defines and maintains two-parameter rate matrix models

with a transition and transversion rates.

TNT, NONA, Hennig86, PiWe, WinClada — Imports and exports
TNT/NONA/Hennig86/PiWe/WinClada files.

Top BLAST Matches — Does a blast search on selected data and returns the top blast
matches for each sequence selected.

Trace All Characters — Summarizes for each node the reconstructions of the states at
all characters of the tree.

Trace Character History — Traces a history of character evolution on the nodes of a
drawn tree.

Trace Character Over Trees — Summarizes at each node reconstructions of the states of
a character over a series of trees. The summary is shown on the current tree; if you
want to show it on a consensus of the trees, make sure that the current tree is that
consensus.

Transform Trees from Other Source — Transforms trees from another source.
Translate DNA to Protein — Translates a stored DNA matrix to protein.

Tree Block Directly From File — Supplies a block of trees directly from a file

Tree Block Values — Makes a chart showing some value for each of many tree blocks.
Tree Blocks from Files Listed In File — Supplies tree blocks in files listed in a file.
Tree Blocks List — Makes windows listing tree blocks and information about them.
Tree Depth — Calculates the deepest path (in branch length) from terminals to the
root, treating unassigned lengths as 0. The length of the root is not counted.

Tree Farm Package Introduction — Serves as an introduction to the Tree Farm package
for Mesquite.

Tree Legend — Makes the legend in a tree window to display the tree name and other
information about it.

Tree of context — Supplies a single tree from the nearest tree context (e.g., an
available tree window).

e Tree Search — Supplies trees resulting from a search to optimize some value.

Tree Search Package Introduction — Serves as an introduction to the tree search
package for Mesquite.
Tree Utility Coordinator — Coordinates use of tree utilities in tree window

e Tree Value Satisfies Criterion — Determines if the tree has a value either greater than,

less than or equal to one specified.

Tree value using 2 characters — Coordinates the calculation of a number for a tree
based on 2 characters.

Tree value using character — Coordinates the calculation of a number for a tree based
on a character.

Tree value using character matrix — Calculates a value for the tree using a character
data matrix.

Tree Window — Makes a basic tree window, which contains a tool palette. Hires
assistants for the tree window (e.g., Trace Character).

Tree Window Coordinator — Coordinates the creation of basic tree windows.
Treelength — Calculates the parsimony treelength of a given tree and matrix.
Treelength — Calculates the parsimony length of a tree.

Trees & Diversification Characters — Evolves a series of trees, each tied to a single
character controlling diversification rates.



Module index 23.10.2007 4:28 PM

Trees Directly From File — Supplies trees directly from a file, without bringing the
contained tree block entirely into memory. This allows much larger blocks of trees to
be used within constraints of memory, but will make some calculations slower. This
module does not know how many trees are in the file, and hence may attempt to read
files beyond the number in the file.

Trees List — Makes windows listing trees and information about them.

e Trees Package Introduction — Serves as an introduction to the basic trees package for

Mesquite.

Trees Scattergram — Makes a scatterplot displaying two values (such as likelihoods,
parsimony scores, imbalance statistics, correlations,etc.) for a series of trees.
Trim Terminal Gap Characters — Trims characters at edges of matrix that are gaps
only.

e Truncate taxon names — Truncates taxon names.

Type of character data matrix — Indicates type of character data matrix (e.g.,
continuous, DNA, etc.).
Type of Model — Indicates type of model (e.g., Mk1, step-matrix) in list window.

e Ultrametricize — Adjusts a tree's branch lengths so that the distances among terminal

taxa are ultrametric (i.e. like a molecular clock, all tips reaching to same level). This
is not done with any sophisticated smoothing algorithm; rather, branches are just
stretched until they reach to same level.

Unambiguous Changes — Counts number of unambiguous changes along branch below
based upon the character reconstruction.

¢ Uncorrected (p) distance (DNA) — Uncorrected (p) distance from a DNA matrix.
e Uncorrected Distance (General) — Uncorrected (p) distance from a character matrix.
e Uniform speciation (Yule) — Generates tree by simple uniform probability speciation (a

Yule process) as done by Harding (1971). The chance of speciation is equal for all tips.
Uniform Speciation with Sampling — Generates tree by simple uniform probability
speciation (a Yule process), with subsequent sampling of species.

Unique ID (characters) — Shows unique id assigned to character.

Unique ID (taxa) — Shows unique id assigned to taxon.

Unique IDs default — Sets the preferences for storing unique ids.

Unroot tree — Sets the tree to unrooted.

UPGMA — Supplies trees obtained from UPGMA clustering.

User-Specified Nucleotide Frequency Model — Defines and maintains user-specified
nucleotide frequency models.

e Utilities — Provides a menu for utilities
e Value for 2 characters with current tree — Coordinates the calculation of a number for

two characters based on a current tree.

Value from Tree — Calculates a value for each taxon using a tree.

Values for Nodes — Shows on a drawn tree various possible humbers at the nodes.
Variable among taxa — Selects characters that are variable among the selected taxa
Web page link — Provides a window to jump to a web page

Whole or Submodel — Indicates whether model is a complete or partial model of
character evolution.

¢ Window Holder — Helps other modules by holding their windows.
e With probability p — Selects characters randomly with probability p.
e Within-group PCA — Performs within-group principal components analysis on a

continous-valued matrix.
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